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Copyright © 2009 by JAMAR Technologies, Inc. All rights reserved. No part of this publication may be reproduced, transmitted, 
transcribed, or translated into any language without the prior written permission of the publisher, JAMAR Technologies, Inc. 

JAMAR Technologies, Inc. Software License Agreement
This software license agreement including any warranties and special provisions, is a legal agreement between you (as an entity or an individual) and JAMAR 
Technologies, Inc.  By installing or otherwise using this software you are agreeing to be bound by the terms of this agreement.  If you do not agree to the terms 
of this agreement, return the unused software, along with all accompanying documentation, to JAMAR Technologies, Inc.

The Software which accompanies this agreement is, and will remain the property of JAMAR Technologies, Inc., and is protected by copyright law.  JAMAR 
Technologies, Inc. is providing you with certain rights to use the Software upon your acceptance of this agreement.

YOU MAY:
1) Use the Software on up to five computers, with the following provisions:
 a) All computers that use this Software are located in the same building;
 b) All persons using the Software are employed by the individual or entity that originally purchased the Software.
2) Use the software on a home computer with the following provisions:
 a) The individual using the Software on a home computer is employed by the individual or entity that originally purchased the Software;
 b) The individual is doing work for the individual or entity that originally purchased the Software.
3) Transfer this license to another individual or entity with the following conditions:
 a) All copies of the Software must be transferred;
 b) No copy of the Software may remain with the original licensee;
 c) All documentation must accompany the Software.
YOU MAY NOT:
1) copy the documentation which accompanies the Software;
2) sublicense, lease, transfer, or rent any portion of the Software;
3) continue to use a previous version of the Software in addition to any updates that may be received.  All copies of previous versions must be destroyed except 
that one copy may be kept for archival purposes;
4) reverse engineer, decompile, disassemble, modify, translate, make any attempts to reconstruct or find the source code for the Software;

U.S. GOVERNMENT RESTRICTED RIGHTS
The Software and documentation are provided with RESTRICTED RIGHTS.  Use, duplication, or disclosure by the United States Government is subject to 
the restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs 
(c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.  Manufacturer is JAMAR Technologies, Inc./1500 
Industry Road, Suite C, Hatfield, PA 19440.

WARRANTY
JAMAR Technologies, Inc. warrants that the media on which the Software is distributed will be free from defects for a period of ninety (90) days from the 
date of delivery of the Software to you.  Your sole remedy for a breach of this warranty will be that JAMAR Technologies, Inc. will, at its option, replace any 
defective media returned to JAMAR Technologies, Inc. within the warranty period or refund the purchase price of the Software.

The Software is provided “as is” without warranty of any kind, either expressed or implied, including, but not limited to, the implied warranties of merchantability 
and fitness for a particular purpose with respect to the Software and accompanying documentation.  JAMAR Technologies, Inc. does not warrant, or make any 
claims that the Software will meet your requirements, or that the Software will provide uninterrupted service, or that the Software is free from errors.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES
In no event shall JAMAR Technologies, Inc. be liable for any damages whatsoever (including without limitation, direct or indirect damages for personal injury, 
loss of information, loss of data, loss of business profits, business interruption, or any other loss) arising out of the use of or inability to use the Software, even 
if JAMAR Technologies, Inc. has been advised of the possibility of such damages or loss.  In any case the entire liability of JAMAR Technologies, Inc. under 
any part of this agreement shall be limited to the amount actually paid by you for the Software.

Windows is a registered trademark of Microsoft Corporation. JAMAR Technologies, Inc. recognizes the trademarks 
of all other companies and products mentioned in this manual.
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If you have any questions about the use of PETRAPro, please call the following number:

800-776-0940
Monday – Friday 8:00 AM to 5:00 PM Eastern time

You may also contact us by e-mail at:

support@jamartech.com

For more information on our products, the latest news in product development, and to download soft-
ware updates, visit our web site at:

www.jamartech.com

For information on all known issues with PETRAPro, go to:

www.jamartech.com/PETRAProsupport

Address any correspondence to:

JAMAR Technologies, Inc.
1500 Industry Road, Suite C

Hatfield, PA 19440

Volume 1.6 September 2009
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What is PETRAPro?
PETRAPro is the analysis software for data collected with JAMAR Technologies hand-held data 
collectors. This program can be used to process data from a variety of studies, including turning 
movement, roundabout movement, classification, multi-direction gap, stop sign delay, signalized 
intersection delay, spot speed, saturation flow and time-stamp. 

PETRAPro, which was released in 2004, replaces the previous software used for this data analysis, 
PETRA for Windows, which was released in 1998. 

PETRAPro was developed with today's practicing engineer in mind, with emphasis placed on ease 
of use while maintaining powerful capabilities. It allows you to download studies from JAMAR 
hand-held data collectors, manually enter data, view and edit the data, print reports and graphs, and 
store the studies for later retrieval. Data can also be exported in several formats for further analysis 
using other programs.

If you would like to get started right away, Chapters 4 & 5 of this manual provide an in-depth tutorial 
on all of the essential aspects of the program needed to start downloading your data and producing 
reports.

Recommended Computer Requirements
• Windows  XP, Windows Vista or Windows 7.
• 64 MB of RAM or higher.
• 20 MB or higher of free space on your hard disk.
• Available USB Port for downloading data

Supported Studies
PETRAPro will download and process the following types of data collected with a JAMAR hand-held 
data collector: Standard Turning Movement, Enhanced Turning Movement, Roundabout Movements, 
Classification, Multi-direction Gap, Signalized Intersection Delay, Stop Sign Delay, Spot Speed, 
Saturation Flow and Time-Stamp.

Supported Data Collectors
PETRAPro reads data from the current hand-held data collectors manufactured by JAMAR, the 
TDC Ultra. It also reads data from data collectors previously manufactured by JAMAR, including 
the IMC-IV, IMC-4, DB-400, DB-100, TDC-8 and TDC-12.

Software Updates
Updated versions of JAMAR software are released periodically and are posted on the JAMAR 
web site. Licensed owners of PETRAPro may download updates to the program to make sure they 
always have the latest version of the software on their computer. To download the latest version of 
PETRAPro, go to www.jamartech.com and then select Downloads from the list of options.

Software Support
If you encounter any problems while using the program, or have any questions on specific operations, 
refer first to this manual and the program’s built-in Help system. For up to the minute information 
on all known issues with the program, refer to the PETRAPro support web page at:
www/jamartech.com/petraprosupport.

 Introduction & Installation
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Definitions
Like any technical field, traffic data collection and analysis has its share of technical words and 
phrases. This program makes use of a few of these. Experienced users will be familiar with many 
(if not all) of these, while new users may not. In any event, before working with the program be 
sure you have a good understanding of the words and phrases used in the program that may mean 
something more specific than they imply.

Turning Movements — This is a generic term that applies to data that has been collected at 
an intersection where the direction of a vehicle (left, through, right) that passes through the 
intersection is recorded.

Standard Turning Movement — This is a term specific to PETRAPro that applies to turning 
movement data that has been classified by up to three groups using the Bank1 and Bank 2 keys 
of the TDC-12 hand-held data collector.

Enhanced Turning Movement — This is a term specific to PETRAPro that applies to turning 
movement data that has been classified by up to fourteen groups using the classification keys of 
the TDC-12 hand-held data collector.

Classification — Data that has been collected with the purpose of determining what types of 
vehicles (motorcycles, passenger cars, tractor trailers, etc.) are traveling over the study site for 
a given period of time. The most commonly used scheme for classifying vehicles is the Federal 
Highway Administration’s Scheme F, which is described in the appendix.

Signalized Intersection Delay — Data that is collected to determine delay information at an 
intersection controlled by a traffic signal.

Stop Sign Delay – Data that is collected to determine delay information at an intersection 
controlled by a stop sign.

Spot Speed — Data that has been collected with the purpose of determining how fast vehicles 
are traveling over the study site for a short period of time. This data is then interpreted to provide 
statistics such as 85th and 95th percentiles. This data is usually collected to determine if longer 
speed studies (usually conducted with an automatic traffic recorder like a JAMAR TRAX) is 
necessary.

Gap — Data that has been collected with the purpose of determining when no traffic (or gaps) 
occur at the study site. Once a gap occurs, this format also records how long the gap lasts, in 
seconds.

Saturation Flow Rate — This is the number of vehicles that could pass through an intersection in 
one hour, if the signal light were always green. This value is used for several design purposes. 

Interval — This is a pre-defined time period into which the data in many of the studies is di-
vided. The most commonly used interval time is 15 minutes.

Site Code — This is a number, or combination of number and letters, used to help identify 
where a specific study was done. This is for optional use. You do not have to enter a site code 
if you do not use them.

Approach — This is a specific direction of traffic that comes to, or approaches, an intersection, 
such as the From North (also known as Southbound) approach , From West  approach, etc. Each 
approach is comprised of several different movements of data.
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 Installing PETRAPro
Begin the installation by placing the PETRAPro CD into your CD-ROM drive. If your CD drive is 
configured for Autoplay, the Installation Options program will start after a few seconds. Otherwise, 
click on the ‘Start’ button on your Windows desktop.  Select Run from the list of options and type 
the command line ‘X:\launch’ where X is the letter of your CD-ROM drive. Press OK and you will 
see the Installation Options for the program.

The Installation Options allow you to do a number of 
things in addition to installing the program.  To begin 
installing the program, click on Install PETRAPro.

The Welcome screen lets you know that the installation 
for the program has begun. During the installation, files 
used by the program will be copied to your computer, 
including some Windows system files. If other programs 
are open and using some of the files that need to be 
installed, an error can occur. Make sure you close any 
programs that are running before you install this or any 
Windows-based software. Click Next and the License 
Agreement screen will appear.

The License Agreement screen allows you to review the 
software license for the program. You must accept the 
agreement in order to proceed with the installation. If 
you do not accept the agreement, the program must be 
returned to JAMAR. If you agree to the license, click 
Yes.

The Information screen of the installation provides an 
opportunity to review the Read Me file that is included 
with the program. This file contains additional infor-
mation on the program and can also be read at the con-
clusion of the installation. Click Next once you have 
reviewed this information.

Figure 1-1: 
Welcome 

Screen

Figure 1-3: 
Information 

Screen

Figure 1-2: 
License 
Screen

Movement — This is a specific portion of data from an approach defined by the direction a vehicle 
moved. A vehicle coming from the east and making a Left turn is part of the ‘Left’ movement 
for that approach. A vehicle making a right turn is part of the ‘Right’ movement, etc.

Groups — Also known as classes, this stands for any data that is collected where specific types 
of vehicles are kept separate. Commonly used groups are passenger cars, light trucks, and heavy 
trucks. 
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The Customer Information screen requires you to enter 
your name, as well as your company’s name. Your serial 
number, which is located on the back of the CD case, 
must also be entered. When entering the number be sure 
to include the dashes. If the serial number is entered 
incorrectly, you will not be allowed to proceed with 
the installation. Once the information has been entered, 
click the Next button to continue.

The Choose Destination Location screen is used to 
select where the program will be installed. The default 
location is C:\Program Files\JAMAR\PETRAPro. Once 
the directory has been set, click Next.

The Select Program Folder screen is used to name the 
folder the program is stored in. Click Next.

Once the Installation program has enough information 
to start copying files onto the computer, the Start Copy-
ing Files screen will appear. You can then review the 
previous choices you have made and if you would like 
to change anything before proceeding, use the Back 
button. Otherwise, click Next and the program will be 
installed.

Chapter 1 — Introduction and Installation

Figure 1-4: 
Customer

Information 
Screen

Figure 1-5: 
Destination

Location 
Screen

Figure 1-6: 
Program 

Folder Screen

Figure 1-7: 
Start Copying 

Files Screen
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 Running PETRAPro

Like most Windows programs, there are several ways you can run the software. Here are two:

1– Open an Explorer window (right click on My Computer and select Explore) and find the 
PETRAPro.exe file, which is probably in the C:\Program Files\JAMAR\PETRAPro folder. Double 
click on the file PETRAPro.exe and the program will run.

2 – Select Start, Programs, and then JAMAR from the list of installed programs. Choose PETRAPro 
from the list, then choose PETRAPro again to run the program.

Figure 1-9: 
Start-up

 Selection

The InstallShield Wizard Complete screen will ap-
pear after the program files have been copied onto the 
computer.

You may be prompted to Restart your computer at this 
point. If you are, be sure to restart before attempting to 
use PETRAPro.

You are also given the option to start PETRAPro im-
mediately, view the Read Me file again, or do both.

Figure 1-8: 
Installation 

Complete 
Screen
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 Navigating in PETRAPro

PETRAPro has been designed to allow you to easily access the many features and options contained in the program. 
The tool bar located at the top of the program allows quick access to some of the program's most common features 
while the drop-down menus provide access to all functions of the program.

Menu Options

Toolbar Icons

Merge
Data

Figure 2-1: Toolbar

Create a
 New File

Open 
Existing 

File

Save
File

Download 
Data

Print
Setup

Print
Preview

Cut

Copy

Paste

Visit 
JAMAR’s 
Web Site

Calculator

Edit File 
Header

Insert
Interval

Delete 
Interval

Insert 
Column

Delete 
Column

Approach
Wizard

Create
Graph

Create 
Variable 
Width 
Graph

Figure 2-8:
 Window Menu

Intersection 
Design

Figure 2-2:
File Menu

Figure 2-3:
 Edit Menu

Figure 2-4:
 View Menu

Figure 2-5:
 Insert Menu

Figure 2-7:
 Tools Menu

Figure 2-9:
 Help Menu

Figure 2-6:
 Format Menu
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Other Navigation and Selection Devices

Tabs
A number of screens in the program contain Tabs to allow access to additional information. To access 
this additional information, click on the tab you wish to go to.

In this example, the General tab is currently active. To select any other the other tabs, such as the 
Titles tab shown below, click on them with the mouse.

Radio Buttons
Many areas of the program contain radio buttons for selecting options and features. In general, you 
click on the circle next to the item to select it. Radio buttons are used when only one option can be 
selected at a time.

In the example shown in figure 2-10 above, taken from the General tab of the Preferences, the Show 
Start Time option has been selected.

Check Boxes
Like radio buttons, many areas of the program contain check boxes for 
selecting options and features. In general, placing a check in the box tells 
the program to include the option or feature listed. No check means the 
option or feature is not to be included. Check boxes are used when more 
than one option can be selected at a time.  In figure 2-12 (taken from the 
Print Setup), Print Comments, Print Peaks and Plot Totals are selected. 
The remaining options are not selected.

Chapter 2 — Navigating in PETRAPro and Using the Help System

Figure 2-10:
Preferences 

– General tab

Figure 2-11:
Preferences 
– Titles tab

Figure 2-12:
Check Boxes
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 The Help System

Like many other Windows programs, PETRAPro 
contains an extensive Help system to aid you in using 
the program. The Help system is essentially a built-in 
manual and most of the information that can be found 
in this printed manual can also be found electronically 
in the Help system.

There are several ways in which to access the information 
that is contained in the Help system. Select Help from 
the list of drop-down menus then choose PETRAPro 
Help Topics to be taken into the contents for the system, 
shown in Figure 2-13. The contents can be used to locate 
the item you want information on or use the Index or 
Find tabs to do a search using specific keywords.

Many screens in the program also contain Help buttons that will automatically pop-up Help 
information related to the screen you are working on. If you are not sure what to do in a certain 
screen, or what some of the available options mean, click on the Help button and detailed instructions 
will appear.

From downloading data, to editing a file, to printing the data, to interpreting the report, all the 
information needed to properly use the program can be found in the Help system.

Figure 2-13:
Help

Contents

Figure 2-14:
Help

 Pop-up
 Window
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 Types of Data Collection
One of the most useful features of the PETRAPro program is its ability to process several different 
types of data. The most common type is Turning Movements. Others types of data are Stop Sign 
Delay, Signalized Intersection Delay, Multi-direction Gap, Classification, Spot Speed, Saturation 
Flow Rate, and Time-stamped, all of which can be collected with the TDC-12.

Turning Movements
The JAMAR hand-held data collectors are designed to make turning movement data collection 
simple and accurate. Collected data can be edited in several ways and reports can be generated for 
overall volumes and peak information.

There are two forms of turning movement data that can be collected, Standard Turning Movements 
and Enhanced Turning Movements. With Standard Turning Movements you can classify up to 
three separate groups of vehicles by using the Bank 1 and Bank 2 keys located near the top of the 
TDC-12.

Enhanced Turning Movement studies allow you to expand the number of groups you can classify 
to up to 14. This is done by using the 14 class keys located near the bottom of the TDC-12. 

Roundabout Movements
Modern Roundabouts are one of the more popular new developments in traffic engineering and are 
being installed at an ever increasing number of locations. However, while the physical design of 
a modern roundabout is different from that of a standard intersection, the resulting vehicle move-
ments are very similar - in most cases either straight, left or right. As such, the data collection for a 
Roundabout Movement study is very similar to a Standard Turning Movement Study.

Classification
The normal use of the term Classification Study involves a manual survey of the types of vehicles.  
Each class is a particular type of vehicle, either a passenger car, a bus, a type of truck, etc. The study 
involves counting the number of vehicles of each class for a given amount of time. PETRAPro allows 
you to process data collected with the Federal Highway Administration’s classification scheme, or 
your own custom scheme.

Signalized Intersection Delay
Data that has been collected at a signalized intersection can be processed to provide a wide range of 
statistics. This includes the total volume recorded, number stopped, total delay, delay per stopped 
vehicle, delay per all vehicles, and percent of vehicles stopped. 

Multi-direction Gap
A gap is normally defined as the amount of time, in seconds, between the end of one vehicle and the 
beginning of the next. You can measure gaps on one lane or two lanes. PETRAPro can then produce 
gap reports for one lane, two lanes, or two lanes with combined gaps.

Stop Sign Delay
Stop Sign Delay data can be processed by PETRAPro to provide a variety of statistics. The program 
will  calculate how long it takes each vehicle to progress through the queue and enter the intersection, 
as well as keeping track of the number of cars in the queue at all times.
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Spot Speed
Spot Speed data can be analyzed to provide speed characteristics at a specified location, typically an 
approach to an intersection. Analysis includes speed percentiles, average speed, pace speed, number 
over speed limit and percent over speed limit.

Saturation Flow
A Saturation Flow rate is the number of vehicles that could pass through an intersection in one hour, 
if the signal light were always green. This value is used for several design purposes and, depending 
on how the data was collected, saturation flow studies can be analyzed not only for saturation flow 
information, but also signal timings and arrival types. 

Time-Stamped
Time-Stamped studies allow you to collect data in any format for your own analysis. The 1 through 
16 keys can be used to record data. Each time stamp is recorded to the thousandth of a second (three 
decimal places). The data can then be exported in spreadsheet format for additional analysis. 
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 Learning the Basics of PETRAPro
This chapter covers all of the essentials needed to begin downloading and producing reports from 
your data. This information is presented in a tutorial style so you can follow along on your computer 
as each aspect is covered. Once you have completed these lessons, you should have a good working 
knowledge of PETRAPro.

Lesson 1 — Setting Your Preferences
Before you begin to use the program to process your data, you need to setup the program to suit 
your specific needs. This is done through the Preferences. The first time you run the program you 
will automatically be prompted to check your preferences. After this, these same settings can be 
accessed by clicking on the File menu, then selecting Preferences.

To start the program, click the Windows Start button, select Programs, then JAMAR, then PETRAPro. 
Once into the program, access the Preferences in the manner described in the previous paragraph.

There are eight tabs in the Preferences that can be used to customize the program. The tab that is 
visible when the screen first comes up is the General tab.

The first option listed is Program Up-
dates. If this option is selected, when 
you start PETRAPro it will check the 
JAMAR web site for updates to the pro-
gram. If an update is available, you will 
be given the option to download it.

An Internet connection is required for 
this feature to work properly. If you have 
an Internet connection, and would like to 
check for updates at start up, go ahead 
and select this option.

The second option is Time Style. This 
setting allows you to use either a 24-
hour military clock or a 12-hour clock 
with AM and PM designations when 

displaying interval times. Select the option that you prefer.

The next option is Speed Units. This setting allows you to choose either miles per hour or kilometers 
per hour when displaying a speed in Spot Speed data.

The next option is Display Time. This setting allows you to use either the start or the end time of 
an interval for display of the data. The most commonly used value is Show Start Time, but you may 
set this either way.

The Skin Selector option allows you to change the look of the program. There are a number of 
optional skins that can be applied to PETRAPro with different themes. You can select a few to see 
if there are any you like. If you prefer the standard Windows look and feel, leave the default No 
Skin setting selected.

Figure 4-1: 
Preferences: 
General Tab
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The next option is Select Language. This setting allows you to set the language used for the com-
mands in the program from those that are currently available.

The Download Options setting allows you to determine how the program should handle multiple 
files that are downloaded from a data collector at one time. The default option, Process all files, 
automatically opens a window for each file when the download is complete. The other option, Select 
Files to Process, brings up a list in the Open File screen of all the files that can be processed. You 
can then choose which specific files to process. Leave the default setting for now.

The Download Options also allows you to decide if you want to include the 'Peds' keys (also known 
as 'Other') as part of the download. JAMAR data collectors are designed with standard Right, Through 
and Left movement keys for each approach, but also have an extra key for each approach that can 
be used to count pedestrians or other things. Some users do not use these keys, and therefore don't 
want to include them with their data. We'll leave this box unchecked.

The next option is Open File Window Style. When opening existing files in PETRAPro, the default 
Open screen searches for all available drives and directories on the computer. The program then goes 
to the currently designated data directory, opens it and reads the headers of all the PETRAPro files. 
This information is then shown in the Open screen. For some users who are on restricted networks, 
or are working with hundreds of data files, this process can be time consuming. The Use Simple 
File Retrieve Window setting tells the program to only look for the designated data directory, and to 
only list the file names, rather than the full header information. This tutorial will cover some of the 
aspects of the standard Open screen so leave this preference unchecked.

The Misc. field gives you a couple options on how the program should act when it starts up and is 
running.

The Main screen is a graphical interface with shortcuts to some of the most common features of the 
program. Leave the Show Main Screen box checked. We'll be discussing this screen a little later on 
in this tutorial.

The Splash Screen is an opening graphic that appears when the program is first started. We'll leave 
this unchecked.

The Treat 'Other' key as Peds option affects how Turning Movement and Roundabout Movement 
data is displayed on the Intersection Plot. When this option is selected, data collected with the 'Other' 
keys (1,5,9,13) while be shown separately on the Intersection Plot. When it is not selected, this same 
data will be grouped with other vehicle data.

The final option, Approach Order, allows you to set a default order for how Turning Movement and 
Roundabout Movement data will be downloaded into the program. The default order is clockwise 
from the top (Southbound, Westbound, Northbound, Eastbound). If you wish to change this, put a 
check in the box Force approach order.  You can then select any approach you want and move it 
using the Up and Down arrow keys.

Once you have finished setting your General preferences, click on the Titles tab at the top.

Chapter 4 — Learning the Basics of PETRAPro, Part 1
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The Titles tab allows you to customize 
the four lines of text that are printed at 
the center top of each page of your re-
ports. The titles can be edited to change 
the font, font style, font size, and font 
color. For the purposes of this tutorial, 
we’ll replace the default titles that are 
stored with the program with your own. 
You may follow the steps below or sub-
stitute your own format as we go.

First, click on the Advanced Edit button. 
This opens a Text Editor window that 
you can use to format the titles. The 
first line of the titles is labeled Your 
Company Name Here. Delete this line 
and enter your organization’s name. 

Next, we're going to change the Font. Highlight the first line, then click the down arrow in the font 
box that currently reads Script MT Bold. Set the new font as Arial, then click the B button to make 
it Bold. The current size of the font is a little large at 18, so we'll make it smaller. Leaving the first 
line highlighted, click the down arrow in the font size box that currently reads 18. Set the new size 
to 14. We're finished with the first line now, so click anywhere in the editor to remove the highlight. 
Notice that the preview screen has been updated to show your changes.  

Next, delete the second, third and fourth lines and enter your address and phone number. When 
done, highlight all three lines and change the Font size to 12, color to black and type to Arial. Once 
all your changes are made, click the Save button and the you'll be taken back to the Titles tab, with 
the new titles in place.

Note that you can store more than one set of titles in your preferences. To create a new set of titles, 
click on the Add button and a blank field will appear. Enter the new title information, and use the 
Text Editor to format. The Delete button can be used to remove any titles that you no longer need. 
You can choose from any of the stored titles when you prepare to print your reports.

In addition to the standard text titles, 
the Titles tab also gives you the chance 
to use a graphic logo on your reports. 
Click the Add Logo button and the Se-
lect Image to Attach window will appear. 
You can use this screen to navigate to 
wherever you have a logo stored on your 
computer. The logo can be in a variety 
of formats, including JPEG, bitmap 
and GIF. 

Once a logo has been added, a few addi-
tional options appear on the screen. The 
Save Logo Option allows you to decide 
if the entire logo will be stored with the 
file or if just a link to the logo's location 
will be stored.

Figure 4-3: 
Preferences: 

Titles
 with Logo

Figure 4-2: 
Preferences: 

Titles Tab
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You are also given the option of where to show the logo on the report. It can be placed on the left, 
right, or center of the report.

Note that you can still use the text titles even if you place the logo in the center of the report. The 
titles will print below the logo. If you don't want to use the text titles and only want to show the logo 
in the center, simply delete the text titles in this screen. 

Once your titles are set the way you want, click on the Comments tab.

The Comments tab works in a manner 
very similar to the Titles tab. The com-
ments listed will print in the upper left 
corner of the report and are designed to 
provide miscellaneous additional infor-
mation with the data that is presented 
in the report.

The comments are expected to change 
from file to file, with information being 
added before each file is printed. As a re-
sult, the information that you enter here 
should be general labels. You will enter 
additional information that is specific to 
each file using the Edit Header function 
described later. 

When you first click on the Comments tab you’ll notice that ‘Default Comments’ is listed, along 
with a message telling you to change them. We’ll replace these with ones that are more useful. First, 
delete the default text on the four comment lines. Next, type in Weather: on the first line, Serial 
Number: on the second line, Collected By: on the third line, and Other Notes: on the fourth line. 
When you are working with a specific file, you will fill out this information (or the information for 
the customized comments you’ve created) using the Edit Header function.

Like the Titles, the font used for the comments can be customized. However, this can only be done 
for the Comments as a whole. Click the Font button and set the font to Arial, Regular, 8.

As with the titles, you can store more than one set of comments in your preferences by using the 
Add button.

The settings that you apply to the comments will also affect the File Comments which are auto-
matically printed in the upper right corner of reports. These comments include the file name, start 
date, site code and page number.

Note that the Comments and Titles have to print on the same lines at the top of page (comments 
on right and left, titles in middle) so you do not want to make the font sizes too big, otherwise they 
will overlap in the printout.

Once you have set the Comments the way you want, click on the Wording tab.

Figure 4-4: 
Preferences: 

Comments Tab
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The Wording tab allows you to cus-
tomize the descriptions used with data 
that you download into the program. 
There are three areas that you can work 
with: the Direction Descriptions, Move-
ments and Groups.  

The Direction Description tab allows 
you to designate how each approach 
direction should be described, such as 
Northbound or From South. When a 
line is selected, an arrow showing the 
direction of the movement appears in 
the Entering Intersection box. You may 
store multiple sets of direction descrip-
tions using the Add button.

The Movements tab applies to Turning Movement data and allows you to designate how each move-
ment should be labeled when your data is downloaded. Most of the movements (right, thru, left) are 
pretty standard and will not need to be changed. However, the ‘Other’ keys (1, 5, 9, 13) of a JAMAR 
data collector can be used to collect a variety of things (pedestrians, bicycles, etc.). The default label 
is Peds but you can change this to whatever you think you’ll be collecting with those keys.  

The Groups tab allows you to designate what names should be applied to the data collected using 
the unshifted, Bank 1 and Bank 2 keys of a Standard Turning Movement file.  A common way of 
collecting data is to record Passenger Vehicles with the unshifted keys, Light Trucks with Bank1 
and Heavy Trucks with Bank 2. You may set these any way you like.

Note that changes made in the Wording tab will only affect subsequently downloaded files – they will 
not affect existing files. Any existing files must be edited within the files themselves. Also note that 
the Movement and Group settings you select in the Wording tab can be overwritten when working 
with a specific data file. How this is done will be discussed in a later lesson.

Once you have set the wording the way you want, click on the Correction Factors tab.

The Factors tab allows you to program 
correction factor tables for use with 
the data. There are two separate tables 
— one for seasonal factors and one for 
daily factors. These factors allow you 
to adjust your data based on historical 
information.

Multiple tables can be stored by using 
the Add button at the bottom of each 
field. These factors can be applied while 
editing your data or when producing 
your reports. Notice that the year in 
the seasonal factors table is ignored 
and therefore is defaulted to 00. For the 
purposes of this tutorial, we’ll leave the 
factors with their default values.

Figure 4-5: 
Preferences:  
Wording Tab

Figure 4-6: 
Preferences: 

Correction 
Factors
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Note that you are not required to use factors with your data. You should only use factors if they have 
been supplied to you, or if you have created them based on historical information. If you are not 
familiar with how to use factors, leave them at the default setting of 1.000.

Once your Factors are set, click on the Default Fonts tab.

The Default Fonts tab allows you to cus-
tomize the fonts that will be used in the 
program and on your reports. There are 
three areas you can set: Street Names, 
Column Titles and Count Data.

Click on the Street Names button. This 
will open the standard Windows font 
screen. You can then set the font in 
any format desired. We suggest using 
the font Arial with the style Bold and 
10 point size, although you may use 
any settings you like. Click OK once 
the font is set. Notice that the preview 
screen updates to reflect the changes you 
have made.

Next, click on the Column Titles button. We suggest the font Arial with the style Regular and 8 
point size for this font. Click OK, and repeat the same process with the Count Data button. Do not 
use large font sizes for the Column Titles and Count data or the reports may not have enough room 
to print them properly. 

Note that changes made in the Font tab will only affect newly created files, they will not affect 
existing data files. Changes can be applied to existing data files using the Format menu that will be 
discussed in a later lesson.

An important option on this screen is the Autofit Text on Reports checkbox. This option allows 
PETRAPro to automatically adjust the font size of any information on a report to fit in the space 
available for it. Leave this box checked.

There are also a couple additional options on this screen that can be used to customize the pro-
gram.

The Select <Enter> Key Action field lets you set how the program will act when you press the Enter 
key while editing your data. The options are to either move the cursor down one cell or to the right 
one cell.

The Format Graphics for Postscript Printing checkbox lets you tell the program if the printer you 
are using is designed for the PostScript programming language. If you are not sure, leave the box 
unchecked. 

Once you have set the Default Fonts tab the way you want, click the Select Side tab.

Figure 4-7: 
Preferences:

Default Fonts
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The Select Side tab allows you to set 
the order of some of the data in the 
program.

The first option is Left Turn Column. 
This setting allows you to choose 
whether the Left Turn movement (Turn-
ing Movement data) of each approach 
will be shown on the left of the display 
or on the right. This also affects how 
your reports will be printed.

The Drive Side option allows you to 
choose whether the vehicles in the 
study are drive on the right (as in the 
United States) or drive on the left (as 
in Europe). Set this according to your 
location.

The Show Peds option allows you to choose whether the Pedestrian column (also called Other col-
umn) is shown and printed on the right side of the approach data or the left.

Once you have set the Select Side tab the way you want, click the Batch Downloading tab.

The Batch Downloading tab allows you 
to customize how files are treated when 
downloaded from a data collector.

If the Use batch downloading option is 
selected, the program will automatically 
assign file names and save the files that 
are downloaded.

The names used when assigning the file 
names depend on the options selected 
on this screen. You can choose to use 
any of the following when assigning the 
names: Site Code, Date, Study Type, 
Count Board Type and Extra text. If 
the program finds any files that would 
otherwise have the same named based 

on the options selected, it adds a number to the end of the file name, starting at 1 and counting up.

The Download Options field allows you to select whether you want to be asked for a path to use 
when the files are downloaded, or if you want to use a pre-assigned path. The menu tree can be used 
to select the pre-assigned path.

You are also given the option of whether or not the files should appear on your screen in PETRAPro 
after they are saved. If the Don’t display files after download box is selected, the files will be saved 
on the computer at the end of the download, but not automatically brought up in PETRAPro.

Figure 4-8: 
Preferences:
Select Side

Figure 4-9: 
Preferences:

Batch
Downloading



9
Note that you can quickly check all of the Preference settings using the Print/Preview Settings button 
located at the bottom middle of the screen. This feature allows you to produce a one-page report of 
all the options and formats you have selected.

Now that we've seen how the Preferences work, we're ready to move on. Click the OK button.

Congratulations! You have completed the first lesson. In this lesson you learned how to set the prefer-
ences for the program. In the next lesson you’ll learn the basics of downloading data and retrieving 
existing data files. You can take a break now, or jump right into the next lesson. 

Chapter 4 — Learning the Basics of PETRAPro, Part 1
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Lesson 2 – Using the Main Screen
The Main Screen of PETRAPro is a graphical interface that gives you quick access to some of the 
most commonly used features of the program. Move your mouse cursor over the various buttons 
on the screen and notice that the display window changes to show a description of the option you 
are currently on.

Try clicking on the Web button. If you have an Internet connection, you should see the PETRAPro 
support web page appear. This page contains up-to-the-minute support information on the PETRA-
Pro program. If you have a question about the program and you cannot find an answer to it in this 
manual, the support web page is the next best place to check.

The Prefs button will take you into the Preferences, which we covered in Lesson 1. You can access 
and change these settings at any time.

The Read button will bring up the Read JAMAR Counter screen, which can be used to download 
data from your data collector. We'll be discussing this in the next lesson.

Click on the New button. This button takes you into the New Count screen, which can be used to 
create a blank file for several types of data. These files are normally used if you need to do manual 
entry of data, or if you need to copy and paste data from other programs into PETRAPro for analy-
sis. You can create blank files for Turning Movement, Classification (FHWA scheme or user-de-
fined), Gap, Signalized Intersection Delay, Spot Speed or Saturation Flow Rate.

Click the Cancel button to exit back to the Main screen.

On the Main screen, click the Open button. This brings up the File Open screen, which is used to 
retrieve files you have previously saved on your computer. We'll be discussing this screen in the 
next lesson, so you can close it for now.

Exit the
Program

Hide the
Main Screen

Access the
Preferences

Visit the
Support
Website

Download 
data

Create a new, 
blank file

Show the 
File Open 

screen

Reopen
 the last

accessed file

Access the
Help menuFigure 4-10: 

Main
Screen
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 The Last button allows you to bypass the File Open screen and directly recall the last data file you 
were working with.

Click the Help button. This brings up the built in Help topics for the program. PETRAPro contains 
extensive Help documentation on all aspects of the program. This Help system is basically a built-in 
manual and most of the information found in this printed manual can be found in the Help system. 
If you get stuck when using the program, many of the screens have Help buttons that provide infor-
mation on the feature you are using.

Next, click the Hide button. Notice that Main screen disappears, leaving only the program's menu 
options and toolbar icons available. You can use these options to access the program's features if 
you prefer not to use the Main Screen.

Go to the File menu, then select Exit. Once the program has closed, restart it. Notice that the Main 
Screen reappears. The Hide selection does not permanently hide the screen, it only hides it for your 
current session of PETRAPro. If you want to permanently hide the Main Screen and use the Menu 
options to navigate the program, go to the Preferences, General tab, and uncheck the Show Main 
screen box that we discussed in Lesson 1.

Congratulations! You have completed the second lesson. In this lesson you learned how to use the 
Main screen to access a variety of features in the program. In the next lesson you’ll use the Main 
screen as a jumping off point to further explore the basics of downloading data and retrieving exist-
ing data files. You can take a break now, or jump right into the next lesson. 

Chapter 4 — Learning the Basics of PETRAPro, Part 1
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Lesson 3 — Downloading Data and Opening Existing Files
This tutorial requires a hand-held data collector with data in it. You can wait to do it until you 
have collected data or just follow along without actually performing the steps.

Once you have performed a study with your data collector you will need to download it to your 
computer so PETRAPro can analyze the data. 

Note that newer data collectors (TDC Ultra) use a USB connection for the download while older ones 
(TDC-12, TDC-8, DB-400, DB-100) use a serial port. The description below is for USB download-
ing with a TDC Ultra. Refer to the Appendix for more details on downloading using the serial port 
connection of older data collectors.

Also note that you should use the optional external power supply during the download process 
whenever possible. The download process draws a significant amount of power, so use of the external 
power supply will prolong the life of your AA batteries.

To download your data, first turn on the TDC Ultra and 
plug a USB cable into it. Then, plug the other end into 
your computer.

Note that the first time you are connecting the Ultra to a computer using the USB port, you will need 
to install the drivers for it. Refer to the Appendix for information on how to do this before proceeding. 
The USB drivers create a virtual comm port that you will select during the download process.

Start the PETRAPro analysis software on your computer, 
and prepare it for download by selecting Read from the 
interface screen. The Read JAMAR Counter screen 
will appear. Note that you can also access this screen by 
going to the File menu, selecting Acquire, and choosing 
JAMAR or by clicking on the Download a Count Board 
icon in the toolbar.

The baud rate setting determines how fast the data will 
be transferred into the program. It must match the baud 
rate set on the data collector. The TDC Ultra's maximum 
speed is 57600, which is what we recommend you use. 
However, you can change the baud rate to any of the 
listed values by first clicking on the Setup button and 
then making your selection.

Clicking the Setup button also allows you to select the Comm Port to be used for the download. A 
comm port will have been created on the computer when the Ultra was connected to it. Select this 
port number. PETRAPro makes the selection easy by only listing the comm ports that are available 
on the computer. 

After setting your baud rate and comm port, click on the Begin button and you will see a message 
prompting you to begin downloading the data collector.

Figure 4-11:
Read JAMAR 

Counter
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The Open File screen works in a manner very similar to Windows Explorer. The directory tree on the 
left side of the screen is used to select the folder where your data files are stored. We want to retrieve 
one of the sample files that was installed with the program, so we’ll need to use the directory tree 
to set the location of these files. The default installation location of this folder is C:\Program Files\
JAMAR\PETRAPro\Data Files. Navigate to this path (or the path you used for the installation) using 
the tree. Once the data folder is selected you will see a list of files on the right side of the screen.

On the Main Menu of the TDC Ultra, use the TAB key to 
highlight DUMP, then press DO. The screen shown to the 
left is then displayed.

Note that the baud rate that the TDC Ultra is currently set 
for is shown on the bottom line. As we previously learned, 

the baud rate is the speed at which the data will be sent from the Ultra to the computer. The baud 
rate set in the Ultra must match the baud rate that has been selected in the software. You normally 
only have to set the Baud Rate once, to match the setting in the software. To set the Baud Rate, use 
the following steps.

Press TAB until Baud is flashing, then press DO. The screen 
shown to the left is then displayed.

Use the TAB key to move the highlight to the baud rate you 
want. Most computers will allow transfer at the fastest baud 
rate of 57,600. Once you have set the baud, press DO. 

As mentioned, once the baud rate has been set, it will be used 
every time for the download, unless you change it.

Press TAB to highlight Continue, then press DO. The screen 
shown to the left is then displayed.

At this point, the TDC Ultra is ready to download. Make 
sure your software is properly set up (refer to the software 
manual if you have any questions on this), then press the DO 
key. The screen shown here will then be displayed.

When the download is occurring you should see a status bar moving across the bottom of the Read 
JAMAR Counter screen. Once the download is complete separate windows should appears for every 
study contained in the data collector. Each file should then be saved with a permanent file name 
you provide.

While you will usually download your data and produce reports all at one time, there may be times 
when you need to open a previously downloaded file for further analysis. In addition, you may have 
older files from other programs that you need to incorporate into PETRAPro. In either case, these 
files can easily be accessed through the program.

Close any files that you may have downloaded. (Don't worry about saving them. You can down-
load them again at a later time. The data can be downloaded as many times as you like. It will 
remain in the data collector until you physically clear it from the unit.)

On the Main screen, click the Open button. This will bring up the Open File screen. You can also 
access this screen by going to the File menu and selecting Open.

Retrieving
 Saved Files

CONTINUE          BAUD
                                   EXIT

Begin local transfer
at 57.6k baud

1200       4800       9600
19.2K      38.4K      57.6K

Select Baud rate,
then press DO.

BEGIN       EXIT
Press DO to start

 dump.
Baud Rate = 57.6k

TRANSFER IN PROGRESS

count#:001
interval#:001
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Note that there are several types of files that can be opened by the program. Files created in PETRA-
Pro, or saved in the PETRAPro format, use a .ppd file extension and will appear in black type.
Files from earlier programs, such as PETRA for Windows or PETRA DOS, use different colors. 
These are the file types that the program is defaulted to look for. However, the program can also 
open files in the IMC (.dfl) and AAP (.vol) formats. To access either of these, select the appropriate 
entry from the drop down list at the lower left of the screen. IMC files appears in green, while AAP 
files appear in red.

The list of files on the right side of the screen contains a variety of information on each file, including 
the file name, type of data, site code, start date and start time, interval length, number of intervals 
and location information. Click on the column title ‘Start Date’ and note that the list of files is re-
arranged in chronological order. The file list can be sorted in a variety of ways simply by clicking 
on any of the column titles.

Note that you can print the list of files in your folder, along with the additional information shown 
in this screen, by clicking on the Print button. The Copy button can be used if you'd like to copy the 
list into another program, like Excel.

The file we want to retrieve is named Sample File - Standard Turning Movement.ppd. Locate this file 
in the list then click on it with your mouse. This will highlight the file. Once it has been highlighted, 
click on the Open button. The Open File screen will close and the file will be opened. You can also 
open files by double clicking on them.

Congratulations! You have completed the third lesson. In this lesson you learned how to download 
data from the hand-held data collectors into the program, and how to open existing files. In the next 
chapter you’ll learn how to work with data files. You can take a break now, or jump right into the 
next lesson.

Figure 4-16: 
Open File 

Screen
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Lesson 4 — Editing Your Data
In this lesson you’ll learn about some of the basic editing functions that can be done with data files. 
For this lesson we’ll be working with the Sample File - Standard Turning Movement file that was 
installed with the program. Other PETRAPro data files (Classification, Gap, etc.)  may look a little 
different but they all use similar editing functions.

If you already have the Sample File - Standard Turning Movement file open, great. Otherwise, follow 
the procedure described in Chapter 4, Lesson 3 to open it.

The first thing we want to do is identify the various parts of the file. The data file contains six main 
areas of information, as shown in Figure 5-1 above: Header Information, Approach Descriptions, 
Movement Descriptions, Group Names, Interval Times and Data Grid. The information in the file 
can be edited using the items in the Toolbar and Menu Options, also shown in Figure 5-1.

____________________________________________________

We’ll start by taking a look at the Header Information. Each PETRAPro file contains not only the 
data for the file, but other information that is pertinent to it, such as the start date, start time, GPS 
location, etc. Most of this information is stored in the file’s header. To edit the header, go to the Edit 
menu and select Edit Count Header. Note that you can also access this feature by clicking on the 
Edit Header icon in the tool bar. This will open the Edit Header Information window.

Notice the Start Date and Time for the file, listed at the upper right. These are read in from the data 
collector when you download your data. If, for whatever reason, the data collector’s date or time was 
set wrong, you can correct it here. Below the Date & Time is the Site Code for the file.

Below the Site Code field is the Group Descriptions field. These descriptions are also read in from 
the Preferences when you download your data. Don’t worry if the descriptions shown for the sample 
file don’t match what you entered in the Preferences. The sample file descriptions were created when 
the file was originally made - changes in the Preferences don’t affect existing files like this one.

Edit
 Header

Figure 5-1: 
Turning

 Movement
 File
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If you want to change the descriptions 
for an existing file you can do so here. 
In this case, it looks like the sample file 
was collected with passenger vehicles 
counted as group 1 and trucks counted 
as group 2. We have no reason to think 
this wasn’t the case, so we’ll leave them 
the way they are. We'll soon see how 
the different groups are displayed in 
the data. 

The top left of the screen contains the 
comments for this file. Notice that the 
sample file has the general comment 

information we entered in the Preferences in Chapter 4, Lesson 1. When a new file is created, the 
program reads in the comments you have set in the Preferences, then you use this Edit Header screen 
to fill in the specifics. That's what we'll do now.

Click your cursor to the right of the colon on line one and type in Sunny. Next, click to the right of 
Serial Number on line two and type in TU-0001, representing the serial number of the data collec-
tor. Now click to the right of Collected By: and enter your name. We don’t have any Other Notes to 
add for line four, so enter None.

That’s it for the Comments. We’ll see how the comments we added apply to our report in a later 
lesson.

Below the Comments field is the GIS Information field. This can be used to enter GPS coordinates of 
where the data was collected. The coordinates can be entered in either the degrees & minutes format 
or just degrees format. The direction of the coordinates (North or South and East or West) must also 
be selected. We'll see how these can be used with your file a little later on in this tutorial.

Click OK and the Edit Header window will close.

You should now be back at the main data screen. We want to save these changes in the file, so click 
on the Save icon in the toolbar. You can also save the file by selecting Save from the File menu. 

If you look at the top of the data Window you’ll see some of the information we just saw in the 
Header listed on the screen, including the Start Date & Time, and Site Code. Also notice the two tabs 
located to the left labelled Passenger Vehicles and Trucks. Each tab contains that group's data. Click 
on the Trucks tab and notice that the data changes to show that group. Click back on the Passenger 
Vehicles tab and the data changes back.

____________________________________________________

Now that we’re familiar with how to see all of our data, let’s look at a few ways we can change it.

The data in the file is presented in a spreadsheet-style, and like other 
spreadsheets it is easy to make changes. Click on any of the cells in the 
file and it will become highlighted. You can then type a value directly 
into the cell. Give this a try. PETRAPro makes it easy for you to manu-
ally enter data.

Cut, Copy
 Paste

Figure 5-2: 
Edit Header 
Information
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Copy
 Formatted

Another easy way to edit your data is though the Cut, Copy and Paste commands. PETRAPro sup-
ports these standard Windows commands, which makes it easy to move data from one column to 
another, from one file to another, or from the program into a different program.

If you need to move your data into another program  to do some custom processing, PETRAPro also 
provides a more advanced version of the Copy command, called Copy Formatted. This command 
allows you to copy over not only your data, but also formatting information like interval times and 
column titles.

To see how this works, click on the Start Time (or End Time) box at the upper left of the data grid. 
This will highlight the entire data grid. Next, go up to the Edit menu and select Copy Formatted. 
This will copy the information to the Windows clipboard. If you have Excel, or some other spread-
sheet program, open it up. Go to the Edit menu, select Paste and you’ll see the data from PETRAPro 
dropped in, along with the interval times and column titles.

In addition to the Copy Formatted command, PETRAPro also gives you the ability to directly export 
your data into the Excel format. In PETRAPro, go up to the File menu, then slide you mouse down 
to Export. A list of export options appear, including Excel. (The other export options are discussed 
in the Appendix.) Select Excel and you are prompted to supply a file name for the new Excel file. 
Once this is done, click OK and the file will be created.

____________________________________________________

Another way you can edit a data file is by changing the number of intervals it contains. This is easily 
done using the Insert and Delete Interval commands. First we’ll see how to add intervals to a file. 
This can be useful if you have files you want to combine using the Copy and Paste commands, or 
if you are manually entering data.

Click on Insert in the menu options, then go to Intervals. You are presented with three options: Add 
to Beginning, Add Before Current Interval and Add to End. For this lesson, we’ll add some intervals 
to the start of the file, so select Add to Beginning. You are then asked how many intervals to add. 
Enter ‘4’ and click OK. Notice that there are now four empty intervals at the start of the data. Also 
notice that the Start Time of the file has changed. Since we added four 15 minute intervals to the 
beginning, the program has automatically changed the Start Time from 6 AM to 5 AM.

Note that the Insert an Interval icon in the toolbar can be used to quickly add one interval to a file. 
When using this icon one interval is automatically added before the currently highlighted interval.

Now that we’ve seen how easy it is to add intervals, we’ll try deleting them. Click on Edit in the 
menu options, then go to Delete Interval. Like with adding intervals, you are presented with three 
options: Delete From Beginning, Delete Current Interval and After and Delete From End. We’re 
going to delete the intervals we just added, so select Delete From Beginning. You are then asked 
how many intervals to delete. Enter ‘4’ and click OK. Notice that the four empty intervals have been 
removed, and the Start Time has been adjusted back to 6 AM.
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Note that the Delete Current Interval icon in the toolbar can be used to quickly remove one interval 
from the file. When using this icon the currently highlighted interval is automatically deleted.

PETRAPro also makes it easy for you to add, or subtract, columns of data. This can be useful if you 
have files that don’t have the standard Right, Through and Left movements for all approaches.

Click on Insert in the menu options, then go to Column. The Add a Column window will then ap-
pear. Note that you can also use the Insert a Column icon to access this screen. 

You use this screen to instruct the program where 
the column you are adding should go. The Entrance 
field should be set to the approach that the data is 
coming from, while the Exit field should be set to 
the approach it is exiting to.

We’re going to add an additional Right column 
coming from the North and headed to the West 
(westbound). Leave the Entrance field set to 1 - 
From North, since this is the North approach, and 
set the Exit field to 7 - From West, since this is the 
West approach.

Notice that the diagram at the lower left of the screen updates to show you the direction of the column 
you are adding. Also notice that the Movement Description field updates as well. The Descriptions 
that appear are the same as the ones that have been set up in the Wording tab of the Preferences, 
covered in Lesson 1. You can use the default or manually add a title. We’re going to pretend this 
column is for Right Turn on Red data, so change the Description to RTOR. We want this column to 
apply to the entire file, so leave the Which Group field set to Add to All Groups. Click OK and notice 
that a new column, titled RTOR has been added to the From North approach.

Deleting a Column of data is even easier than adding one. To do 
this, you start by highlighting the column you want to remove. 
We’ll remove the column we just added, so click on the RTOR 
column title and the entire column will be highlighted. Next, 
click on the Edit menu and select Delete Column. (Note that 
you can also use the Delete Current Column icon to access this 
feature.)

The Delete Current Column window will then appear, asking 
whether you want to delete the column from just the active group 

or all groups.  We’re going to remove it from all groups, so leave the default setting and click OK. 
Notice that the RTOR column is now gone.

In addition to adding columns of data, PETRAPro allows you to move existing columns to new 
locations, or edit their titles. This is especially useful if you used the Other keys (1, 5, 9, 13) to 
record movements other than the standard right, through and left at an intersection. To see how this 
works, double click on the Rght column title in the From North (Southbound) approach, and the 
Edit (Move) A Column window will appear. Note that you can also access this screen by selecting 
Edit (Move) Column from the Edit menu.

Notice that this screen is essentially the same as the Add a Column screen described earlier. You 
can use the Entrance and Exit fields to change the direction of the column and use the Movement 

Edit (Move) 
A Column
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Description field to change the title. We’re not going to move any of the columns in the sample file, 
so click on Cancel.

Note that the Movement Description field should not be changed to a different movement name 
without also changing the actual Entrance or Exit fields. If we were to change the description of 
the Right column we selected to read Left, the title would change but the data would still appear as 
right turn data in any diagrams of the intersection.

____________________________________________________

 In addition to giving you a lot of flexibility for adding or removing data in a file, PETRAPro gives 
you a lot of flexibility in how your data should look. You can choose custom fonts for the Street 
Names, Column Titles and Count Data of your file by using the Format menu. Each of these selec-
tions allows you to choose a font type, font style, and font size.

The fonts that are used when a file is downloaded are taken from those that are set up in the Fonts tab 
of the Preferences screen. Since we took the time to set the fonts while we were in the Preferences 
(refer to Chapter4, Lesson 1 for more information on this), we’ll apply them by using the Set to 
Default option. Click this selection and notice that the fonts of the file are changed to match what 
we designated in the Preferences screen.

Another benefit that PETRAPro gives you is the ability to view your data in several different formats. 
To see a few of these, click on the View menu. Move to Size and notice that you are given several 
ways to change the size of your data file window.

Below Size are two selections, As Numbers and As Gradient, that let you see your data in two differ-
ent ways. The program is defaulted to show you your data as numbers; that’s what you are looking at 
on the screen right now. The As Gradient selection lets you see your data as shades of color, which 
can be very helpful in getting a quick understanding of your traffic volumes. There are four colors 
you can pick from: Red, Green, Blue and Gray.

Click on the Red selection and notice that the data grid changes from showing numbers to showing 
colors. The black areas represent low volumes, while the red areas represent higher volumes – the 
lighter the red, the higher the volume. You can now easily see that the highest volume movements 
for the file are the through movements for the From East and From West approaches, with some 
additional elevated volumes for the Right movement on the From South approach. When done 
looking at this, go back to the View menu and reselect As Numbers. Your file should then be back 
to the default view.

The last item in the View menu is the Count Info Status bar. This is a useful feature, located at the 
bottom left of the data screen, that lets you quickly and easily see volume 
information by providing Column and Row totals for any highlighted cell.

____________________________________________________
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Before we conclude this lesson, we want to save all the changes that we made to the sample 
file. There are several ways you can do this. The quickest way is to click on the Save icon 
in the toolbar. This immediately saves the current file using the existing file name.You 
can also save the file by going to the File Menu, then selecting Save. 

If you want to change the name of the 
file before you save it, or if you want to 
change the location of where the file is 
saved, you can use the Save As option. 
Click on Save As in the File menu and 
the Save As window will appear.

The Save In field at the top of the win-
dow can be used to change the location 
of where the file is saved. The File Name 
field near the bottom of the screen can be 
used to change the name of the file.

Note that if you want to save the file 
in an older JAMAR format, such as 

PETRA for Windows or PETRA DOS, you can do so by changing the Save As Type field at the 
bottom of the screen.

We're just going to save the file with its current name, in its current location, so click Cancel to close 
the Save As window. Then, click on the Save File icon in the toolbar to save the file. 

Congratulations! You have completed lesson four. In this lesson we learned some of the standard edit-
ing techniques for data files. In the next lesson we’ll learn how to use some of the Tools PETRAPro 
has. You can take a break now, or jump right into the next lesson.
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Lesson 5 — The Tools Menu
In this lesson you’ll learn about some of the options that are available in the Tools menu, a selection 
of functions that let you further define and customize your data files. For this lesson we’ll again be 
working with the Sample File - Standard Turning Movement file that was installed with the pro-
gram. If you already have the sample file open, you’re ready to go. Otherwise, follow the procedure 
described in Chapter 4, Lesson 3 to open it.

Intersection Design Tool
The first selection in the Tools menu is Intersection Design. Select this from the menu and the 
Intersection Geometry window will appear. You can also access this screen by clicking on the In-
tersection Design icon in the toolbar.

The Intersection Geometry tool al-
lows you to enter street names of your 
intersection and provide a graphical 
representation of where your data was 
collected. This can be very beneficial in 
helping people who look at the data have 
a better understanding of it.

Up to eight different approaches can 
be defined, with options for selecting 
the number and type of inbound and 
outbound lanes as well as median di-
viders. 

The tabs on the right side of the screen 
are used to select the approach you want to work with. To edit an existing approach, click on its tab 
(From East, From West, etc.) or click on the approach leg itself and the program will automatically 
call up the corresponding tab.

The first thing we'll do is enter street names for our file. Click the From North approach and enter 
Main St. as the name of the approach. Notice that the picture of the intersection on the left updates 
to show the new name. Next, click the From South approach tab. Notice that the program automati-
cally fills in the street name that you just enter for the From North approach. If an approach's street 
name is blank (like the From South was) the program will automatically update it with the name 
from the corresponding approach, saving you the trouble of retyping it.

Note that you can override this feature by simply typing in a new name for those rare cases when 
the street name may be different on opposite sides of the intersection.

Next, click on the From East approach tab. Enter Broad St. as the street name for this approach, then 
click the From West tab and the name will be copied over. 

Now that we've entered our street names, we'll make a few changes to how the intersection itself 
actually looks.

The default view that you see for the sample file is pretty accurate for its intersection, but we’re go-
ing to make a few changes anyway just so we get a better feel for how this tool works. Click on the 
From South (or Northbound) tab so this approach is active. We’re going to add a Left Turn lane to 
this approach, so click in the Left Turn box and enter a 1. Lanes can be added for straight, left turn, 
right tun and outbound by changing the number listed in each of these boxes. Median dividers can 
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be added by using the Between In and Out box. Notice that when we add a 1 to the Left Turn box 
the display updates to show the change. However, it doesn’t look exactly the way we want.

First, we want to make the lanes a little smaller so they are easier to see. To do this, use the Lane 
Width slider bar at the lower right of the screen. This is currently set to 100, so slide it to the left with 
your mouse until it says 90. Notice that the display look a little different now. Next, we’re going to 
add a corresponding left turn lane to the From North approach. Click on this tab, and add a 1 to the 
Left Turn box. Now we want to line up the approaches a little better.

The North, South and East approaches look pretty good, but the West approach is a little off. Click 
on the From West tab so this approach is active, then begin clicking the left arrow in the Offset Ap-
proach field to move the approach to the left until it lines up with the other approaches.

While the arrows in the Offset Approach field can be used to move approaches left and right, or up 
and down, you can actually do this even easier by using your mouse to click and drag an approach. 
Click your mouse on the From West approach and, while you hold the mouse button down, move 
the mouse up and down, left and right. Notice that the approach moves with the mouse. You can do 
this with any of the approaches simply by clicking on them and holding the mouse button down. 
Once you are done, re-position your approaches so they are again lined up.

Now that we’ve seen how to set up the intersec-
tion geometry, let’s see how to customize the 
look of it. The green background is a little hard 
on the eyes, and the yellow text for the street 
names is difficult to see, so we’re going to 
change these.

Click on the Toolbox icon in the toolbar and the 
Intersection Design Properties window will 
appear. There are a number of different areas of 
the design you can change, including background 
colors, street colors, and line styles. The first 
thing we are going to do is change the green, 

which is actually controlled by the Non-Street Area tab (this is the area in front of the background, 
not on the street itself).

Click on the Select Color button of this tab,  change the color to a purple or dark blue, then click OK. 
(If you use a black and white printer you 
may want to choose a dark gray.)

Next, we’ll change the color of the text, 
so click on the Text tab. Click the Select 
Font button and the standard windows 
font screen will appear. Change the font 
color to white and to make the text stand 
out a little more change the size to 48 
and the style to bold. Once this is done, 
click OK.

The divider lines between our left turn 
lanes and the other lanes seem a little 
large, so we'll adjust them as well. Click 
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on the Lane Divider tab and notice the slider bar on the left. (Similar to the one we used earlier to 
adjust the lane width.) 

Click on the slider and notice that it is currently set to 5. Hold down your mouse button and slide 
the bar to the left until it is set on 1. You can then click OK to exit out of the Design Properties. Your 
intersection should now look similar to the one in Figure 5-9.

Now that we have set the look of the intersection to the way we want it, we'll add some additional 
items to it that will provide more details.

Click on the binocular icon in the toolbar. Notice that the right side of the window changes to show 
a variety of images. The binocular icon lets you change the view of the intersection window. By 
clicking on it you can change from the design view, to the icon view, to the digital photo view. (We'll 
be covering the digital photo feature shortly.)

The icon view can be used to add graph-
ics to your intersection. Any of the icons 
can be placed on the intersection by 
clicking and dragging them. For our 
intersection, we'll add pavement mark-
ings to indicate the two left turn lanes. 

Click on the left turn arrow in the icon 
list (first icon on the second row) and, 
while holding the mouse button down, 
drag it into the left turn lane of the From 
South approach.

Now, repeat the same process and place 
the arrow in the left turn lane of the 

From North approach. Notice that the arrow is not facing the way we want. We need to rotate the 
icon to face the correct way and to do this we'll use the Rotate icon in the toolbar.

Whenever you have an icon selected, four items in the toolbar become 
active: the Delete, Rotate, Reduce and Enlarge icons. These can be 
used to change how the icon looks.

Click the Rotate icon and notice that the turn arrow starts to rotate. Click it a few more times until 
it is facing the correct direction.

Scroll down through the list of icons and notice the different ones that can be used, including pave-
ment markings and street signs. You can place these in any combination that you like. We used just 
two for this tutorial, but you can use as many as you like with your files.

In addition to the graphical icons, you can also add a text box icon to the intersection if you want to 
include a text message. To do this, click on the Notepad icon in the toolbar. You can move the text 
box around just like any of the other icons. To enter text, double click on the box and a cursor will 
appear. Type in 'Test Message', then press Enter on your keyboard. Note that you must press Enter 
on the keyboard whenever you are finished making text changes to the box.

Notice that you can't see the text. This is because our font color is white and the background is cur-
rently white. To resolve this, we'll make the background transparent. Click the down arrow next to 
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the Notepad icon and notice the list of options. These options can be used to change the text box 
border, background, alignment and font. Click on Transparent and the white background will disap-
pear, allowing the text to be seen.

We don't need to keep the test message, so delete it by clicking on it to highlight it and then clicking 
on the Delete (scissors) icon.

Now that we've seen how the icons work with the intersection, we'll take a look at the next feature. 
Click the binocular icon again and the photo view will appear.

This feature allows you to include a digital photograph of your intersection with the data file. No-
tice that when we first access this screen it is blank since we haven't added a photo yet. That's what 
we'll do now.

To add a photo to your file, click the Camera icon in the toolbar. This will open the Select Image to 
Attach window which can be used to select the file you want to attached. Images can be in any of 
the following formats: Windows bitmap (.bmp), JPEG (.jpg), Windows Metafile (.wmf), Enhanced 
Metafile (.emf) or GIF (.gif).

A sample photo was installed when 
you installed PETRAPro. We'll at-
tached this picture to our file. The file 
is named intersection.jpg and should 
be in your PETRAPro Data File folder. 
(The default path is C:\Program Files\
JAMAR\PETRAPro\Data Files). Locate 
this file, select it and then click the Open 
button. The picture should then appear 
in the Photo view. 

Note that there are two ways you can at-
tach a photo, Embed or Link. These op-
tions can be accessed by clicking on the 
down arrow next to the camera icon.

The Embed option adds a copy of the photo to your data file (making the file larger). The Link op-
tion only adds a link to where the file is currently stored on your computer. In general, the embed 
option should be used if you will be sending the data files to other people while the link option 
should be used if the files will always be on your computer (and the location of the digital photos 
won't change).

Once you are satisfied with the design of the intersection, and the digital photo selected, you can 
print these by themselves using the Print button, or include them with the full report for your data 
file. We’ll cover how to do this in a later lesson.

We want to save the changes we made so far, so go to the File menu and select Exit and Save Changes. 
Once you are back in the main data file screen, click the Save icon to save the file.

Note that there are a wide variety of ways you can change the look of the intersection design. We 
covered just a few to give you an idea of what you can do – use can use your own creativity when 
you start to work with your own data.

____________________________________________________
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Approach Wizard
The next selection in the Tools menu is the Approach Wizard. This wizard allows you to make a 
number of changes to the approach information in a file. We've covered some of the features of this 
wizard already, but there are a few new ones as well.

To access this wizard, go to the Tools menu and 
select Approach Wizard. The Approach Wizard 
window will then appear. Note that you can also 
access the wizard by clicking on the Approach 
Wizard icon in the toolbar.

The first selection on the list, Go straight to the 
Intersection Design tool, gives you the chance 
to go into the Intersection Design tool that we 
just covered. We don't need to revisit this, so 
we'll move on.

The second selection on the list, Delete an ap-
proach along with all the references to it, allows you to quickly and easily remove an entire approach 
from your data file. To give this a try, click the radio button next to this option, then click Next.

The next screen lets you select the approach 
you want to remove. You can choose the ap-
proach from the box near the top of the screen. 
Click the down arrow of this box and select the 
From South approach. Notice that the large ar-
row graphic on the screen changes to show the 
direction of the approach you have selected. This 
graphic allows you to be sure you have selected 
the correct approach.

Click the Finish button and notice that the From 
South approach has been removed. Also notice 
that the movements from the other three ap-

proaches that would have been going to the From South approach have also been removed. When 
you delete an approach, all references to it from the other approaches are also deleted.

We don't actually want to permanently delete the From South approach, so we'll reverse the action 
we just took using the program's Undo function. This is a very useful feature that lets you undo the 
last change you made to a file.

Click on the Edit menu and the option at the top should be Undo Delete Approach. Click this option 
and the file will be restored to its previous state. Note that the Undo option will only work for the 
last action you took. You cannot do multiple undos.

Go back to the Approach Wizard, select the third item on the list, Add a new approach and reference 
it from the currently existing approaches, then click Next. This selection is basically the same as the 
Delete approach selection, but in reverse. It allows you to add a new approach to the existing ones. 
Use the default selection (From Northeast) and click the Finish button. Notice that the new approach 
has been added, and that it is now referenced from the other existing approaches. We don't need this 
new approach, so use the Undo again to restore the file. 
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The next selection in the Approach Wizard is Change the direction of an approach. This option is 
usually used if you collected data at an intersection where there were four approaches but one (or 
more) of the approaches was not from one of the standard north, south, east or west directions.

Let's pretend that the From North data of our 
sample file was actually for a From Northeast ap-
proach. Select the change direction option, then 
click Next. The next screen allows you to select 
the approach you want to change and shows you 
how it will be changed. The screen is already set 
to how we want to change the approach, so just 
click Finish.

Notice that the From North approach has been 
changed to From Northeast. Also notice that 
the movement descriptions of the approach 
have been changed, as have those of the other 

approaches that would be going into the new direction.

We don't want to permanently change the direction of the approach, so use the Undo option to reset 
the file, then go back to the Approach Wizard.

The next item on the list is Rotate the position of the count board.

When data is downloaded from a JAMAR hand-held data collector, PETRAPro assumes that the 
From North approach was counted with the 1 through 4 keys, From East with keys 5 through 8, From 
South with 9 through 12 and From West with 13 through 16. In fact, the turning movement diagram 
on the data collectors has a compass depiction that indicates the North direction.

Ideally, when in the field collecting data you would turn the data collector so that the compass faces 
North. However, some people do not like to do this, preferring to count with the data collector in 
its standard position regardless of the direction they are facing. This is where the rotate count board 
option comes in handy. It allows you to orient your data in PETRAPro regardless of how it was 
collected.

Select this option in the wizard, then click Next. The Rotate Count Board window will then ap-
pear. 

The Count Data Currently In: list shows how 
the data is presently laid out and below it is a 
color-coded display of the current layout. The 
Will be Moved To: list shows any of the changes 
you’ve set.

To rotate the data you use the up and down ar-
rows on the right-hand side of the screen. The up 
arrow rotates the data clockwise, while the down 
arrow rotates the data counterclockwise.

Let’s pretend that when the data for the sample 
file was collected the person doing the data 
collection was actually facing South. Click the 
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down arrow twice and notice that the Will Be Moved To: list changes along with the color-coded 
display below it. Now click the Apply button. The data that had been in the From North approach is 
now in the From South approach, and vice versa. The same is also true of the From East and From 
West data. Notice, however, that the order of the approaches hasn’t changed – we’ve only moved 
the data itself.

We don't want to permanently change the data, so use the Undo option to reset the file, then go back 
to the Approach Wizard.

The next selection in the Approach Wizard is Delete a set of columns.

JAMAR hand-held data collectors contain four 
groups of keys for each approach: left, thru, right 
and 'other'. The 'other' keys can be used to count 
a variety of things, like pedestrians or bicycles. 
However, you can also choose not to use them at 
all. If you don't use these keys, the Delete a set 
of Columns option allows you to remove them 
from the file easily.

Select this option from the list, then click Next. 
The next screen allows you to select the set 
of columns to remove. We'll remove the Peds 
column that is already selected, so click Finish. 

Notice that the data file has been changed and all the Peds columns have been removed.

We don't want to permanently delete the Peds, so use the Undo option to reset the file, then go back 
to the Approach Wizard.

The final option in the Approach Wizard is Change the order of the approaches. 

Turning Movement files in PETRAPro are defaulted to be listed in clockwise order starting from 
the top (From North, From East, From South, From West). If you don't like this order, the Change 
the order of the approaches option allows you to change it.

Select this option, then click Next. The Order Approaches 
window will then appear. The current order of the ap-
proaches is listed from top to bottom - North, East, South, 
West. To move an approach, you click on it and then click 
on the large up and down arrows until it is placed in the 
order desired. Let’s give this a try.

Click on the From East approach in the list of options, 
then click the up arrow once. This moves From East up, 
and drops From North down. Click OK and notice that 

the data in the sample file moves to reflect the change we made. You can use this tool to rearrange 
the approaches of a file in any order you like.

We don't want to permanently change the order, so use the Undo option to reset the file.
____________________________________________________

Figure 5-16: 
Approach 
Wizard –

Delete
Column Set

Delete
Column Set

Figure 5-17: 
Order

Approaches

Order
Approaches



15

Merge Wizard
The next tool we are going to look at is the Merge Wizard. This is one of the more powerful features 
of PETRAPro. It allows you to quickly and easily combine multiple files into one. 

The Merge Wizard will only work if you have two or more files open on the screen at one time, so 
we are going to make a copy of the sample file for this lesson. You should still have Sample File 
- Standard Turning Movement open – if not, open it now. Go to the File menu and select Save As. 
This will open the Save As window, which, as we saw before, lets you save a copy of an existing 
file with a new name. Change the file name to Merge Sample and click the Save button. We’ve now 
saved a copy of the sample file – while keeping the original file as well.

For this lesson we’re going to chain the data from our Merge Sample file to the end of the original 
sample file. Since both files have the same start time, we’re going to change the start time of the 
Merge Sample file and pretend that its data was collected at a different time of the day. The original 
start time is 6 AM and the data goes through the 5:45 PM interval. We’re going to change the start 
time of Merge Sample to 6 PM, so we’ll end up with two files that have 12 hours of data.

To change the Start Time of a file you use the Edit Header function, as we covered in Lesson 4. Click 
on the Edit Header icon, then go to the Start Time field. The times used in this screen are military, 
so enter 18:00. Click OK and notice that the time of the file has now changed to 6 PM.

Now that we have the file ready to go, let’s reopen the original sample file. Go to the File menu, but 
don’t select Open this time. Notice instead that at the bottom of the File menu is a list of recently 
used files. PETRAPro keeps a list of the last eight files used and displays them here for easy access. 
Locate Sample File - Standard Turning Movement in the list and click on it to open it.

We’re now ready to use the Merge Wizard, so 
go to the Tools menu and select Merge Wizard. 
The first of the Wizard screens will then appear 
on the screen. Note that you can also access this 
screen by clicking on the Merge Wizard icon in 
the toolbar.

The first screen you see allows you to select 
the files you're going to merge. If you have 
more than two files open you can choose the 
two you want. Note that the Merge Wizard will 
only merge two files at a time. Select Sample 
File - Standard Turning Movement as the First 
Count, Merge Sample as the Second (Destina-
tion) Count, then click Next.

The next screen asks us to select the dates we 
want to use for the files. This is mainly for when 
you are merging files with different dates. That's 
not the case with our files, so just click Next.

The next screen prompts us to decide which 
groups of each file we want to combine. You can 
do just one group, or more than one, depending 
on your need.

Figure 5-18:
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– Select Groups
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In most cases you'll be combining all the data in 
each file, so to do this click the Add All button 
then click Next.

The last screen of the Merge Wizard contains 
some error checking selections. In a typical file 
merge, data would not normally exist at the same 
point in the files being combined. However, if it 
does you must decide how the program should 
deal with it. The options you have are: Average 
the two point, Add them together, Use the value 
from [file 1], Use the value from [file 2], or 
Cancel the Operation. 

Our files should not have any overlapping data, so we’ll want to stop the operation if the program 
finds any. Click on the Cancel the Operation radio button.

Note that the Final Options also contains a feature that can be very helpful in finding potential prob-
lems. The Pause and tell me if this happens checkbox, if selected, will stop and give you a warning 
if the program does find data at the same point in both files. The warning tells you at what interval, 
column and group the overlapping data was located.

Below the Final Options are the File Options. These two options let you decide if the merged data 
should be placed in a new file, or placed in one of the existing files. We're going to have a new file 
created, so leave the default option of Place results in a new count selected.

Now that we have all of our options selected, click on the Finish button. PETRAPro will then create 
a new file, combining the data from the two existing files in the manner we have specified. Notice 
that our new file has 96 intervals, 48 from each original file. At this point you would normally save 
the new file. We recommend that you save the file with a name different than the original two files 
so you can always got back to the originals if you encounter a problem. We don’t need to save our 
merged file this time, so you can close it without saving it. Go ahead and also close the Merge 
Sample file.

Note that while the Merge Wizard automates the process of combining files, you can also combine 
files though simple Copy and Paste commands. This can sometimes be quicker when you are deal-
ing with short files.

____________________________________________________

Correction Factor
The next item on the list of Tools is Correction Factors. This tool can be used to apply an adjustment 
factor to the data in the study. This is typically done to increase or decrease volumes, either for all 
the data or for just a specific movement. Factors can be applied from the Seasonal Factor Table or 
Daily Factor Table of the Preferences, or from a universal User Supplied Factor.

Note that applying a factor with this tool will change the actual data of the file. If you wish to factor 
your data without actually changing it you can apply a factor to your finished report. The procedure 
for doing this is explained in a later lesson.

Let’s take a look at how this tool works. Go to the Tool menu and select Correction Factor. The 
Factor Data window will then appear on the screen.

Figure 5-20: 
Merge Wizard

– Final Options
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The top of the screen contains the 
selection boxes for Seasonal or Daily 
factors. The Factors tab of the Prefer-
ences can be used to store multiple sets 
of factor tables. Refer to Lesson 1 for 
more information on this.

To use a factor from one of the tables  
you click on the Previous or Next but-
tons to select the table you want. Once 
the table you want has been selected, 
be sure to place a check in the Apply 
Factor box. We aren’t going to apply 
any seasonal or daily factors to our data, 
so you can leave the default settings in 
place.

Below the Daily Factor field is the User Supplied Factor field. This field allows you to enter one 
universal factor and apply it to your data, which is what we’re going to do now. Change the value 
listed from 1.000 to 2.000, then place a check in the Apply User Factor box. Notice that the Final 
Factor table at the bottom of the screen updates to show this selection. This table is useful for keep-
ing track of the factor you are going to use if you are using a combination of seasonal, daily or user 
supplied factors.

To the left of the User Supplied Factor field is the Which Groups field. This is used to instruct the 
program how to apply the factor. In our case, we’re going to use the default setting and only ap-
ply it to the current group. Click the Apply button and notice that the data in our file has now been 
doubled. Applying a factor of 2 tells the program to multiply all the data points by 2, which results 
in double the amount of data.

Now that we’ve seen how applying a factor can affect the data, let’s change the data back to its origi-
nal volumes. Change the User Supplied Factor to 0.5 then click the Apply button again. Applying a 
factor of 0.5 tells the program to multiply all the data points by 0.5, which results in it being divided 
in half. The data is now back to where we started. Click Quit to exit the Factor Data screen.

Note that factors do not have to be applied to all the data in the file, or all the data in a group. You can 
apply a factor to any specific portion of the data by highlighting the data you want to factor before 
going to the Correction Factor tool. Any factor that is applied will then only affect the highlighted 
data. This can be especially useful if you want to factor specific movements, like all Left movements 
or all Right movements.

____________________________________________________

Graphs
The next tool on the menu is Graphs. PETRAPro contains a powerful graphing engine that allows 
you to create visually informative charts and graphs in a matter of minutes. With this tool you can 
present your data in an almost unlimited number of formats. For this lesson we’ll create just one of 
the many formats, and along the way show some of the functions that can be used to create com-
prehensive graphs.

You should still have Sample File - Standard Turning Movement open – if not, open it now. To ac-
cess the graphs, go to the Tools menu then select Graphs. This will open the Turn Graphs Window. 
Note that you can also access this screen by clicking on the Graphs icon.

Figure 5-21: 
Factor Data
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The initial graph screen that appears breaks down 
each movement of each approach over the entire 
length of the file. For this lesson we will change 
the graph to a three dimensional pie graph rep-
resenting the data from the four approaches for 
the entire length of the file.

Note that graphs can be created from any portion 
of your data; you do not have to graph all of the 
data. To graph a portion of the data, highlight the 
specific area you want graphed then click on the 
graph icon. This can be used to graph a specific 
time period, or individual approaches.

The initial graph is a little confusing, so we'll 
make a few changes to make it clearer. To do 
this, we'll use the Options menu.

The Sum Intervals and Sum Approaches options 
allow you to combine data to present it more 
clearly. Select Sum Interval and the data will 
be consolidated. Next, select Sum Approaches 
and the various movements within an approach 
are combined.

The other selection in the Options menu is Type. 
PETRAPro allows you to create a wide range 
of graphs in both 2D and 3D format. Two-di-
mensional graphs include Bar/Pictograph, Line, 
Area, Step, Horizontal Bar and Pie. Three-di-
mensional graphs include Column, Tape, Area, 
Step, Horizontal Bar and Pie. Select Pie from the 

3D selections and the graph is changed from a two dimensional bar graph to a three dimensional pie 
graph like the one seen in figure 5-23.

Now that we have the graph set up to show the data the way we want, we’ll make a few more 
changes to make the graph even more descriptive. For these changes we’ll be working with the 
Chart Designer.

The Chart Designer is a tool used to edit the more 
technical aspects of charts and graphs. You can 
start the designer by right-clicking on the graph 
and selecting Chart Designer from the pop-up 
window. However, it is usually better to start the 
designer by double-clicking on the area of the 
graph you want to edit, as this takes you directly 
to that location in the designer. We’re going to 
add labels of the actual volume total for each 

approach to the graph, so start by double clicking on the box next to Main St. From North.

The Chart Designer opens and takes us directly to the selection for Main St. From North. Click on 
the ‘+’ sign next to this series and you’ll see the options that are available. Click on Datapoint Labels. 

Figure 5-22:
 Default 

Graph

Figure 5-23:
 Initial

3D Pie Graph

Figure 5-24:
 Chart

Designer
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The Text Location field in the Appearance tab 
is what we need to change to have the datapoint 
labels appear in the graph. The default setting 
is for None. You can choose to have the labels  
shown either inside the section of the graph or 
outside it by selecting the appropriate entry. 
Since there isn’t much data for the From North 
approach (and therefore its slice of the pie is 
pretty small), we’ll select Outside. Click on the 
OK button and you will see the volume totals 
listed in the graph for this approach.

Next we’ll do the From East approach. Double 
click on the box next to it and then go to the 
Datapoint Labels selection the same way did 
previously. The From East approach has the 

most data of the file, so its pie slice is pretty big. Since this is the case we’ll put the label right on 
the slice by selecting Inside. Once this is done, click OK and you’ll see the new label, this time on 
the graph itself.

Double click on the box next to From South and 
repeat the same procedure, selecting Inside. This 
time, however, we’re going to change the format 
of the label. The pie slice for the From South 
approach is a little dark, so to make the label 
easier to read we’ll have it be in white text rather 
than the default black text. To do this, select the 
Font tab of the Datapoint label screen (several 
tabs over from the Appearance tab we have been 
using). The font tab works just like the standard 
windows font tab, allowing you to change the 
type, style, size and color of the text. We’re just 
going to change the color, so select white and 
click OK. The label is added on the graph, but 
this time in white type.

Now do the final approach, From West. You can 
choose whether to put the label inside or outside, 
and pick whatever style you want.

With the labels added to the graph it is more 
informative, but there’s another change we can 
do to make it even better. The default title for the 
graph is the data file’s name and location but this 
may not mean too much to the person looking 
at the graph. We’ll change it to make it more 
descriptive. Double click on the current title and 
you’ll be taken back into the Chart Designer, but 
this time to the Title selection.

Click on the Text tab and delete the current title. 
You can then enter any title you want that you 

Figure 5-25:
 Graph with
First Label

Figure 5-26:
 Graph with

All Labels

Figure 5-27:
 Final
Graph
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think will help properly describe the data. One example would be Approach Volumes for Passenger 
Vehicles. Once you have added the new title click OK.

The completed graph can be printed by selecting Print from the File menu. It can also be copied for 
pasting into other programs by selecting Copy from the Edit menu.

This tutorial covered just a few of the many ways you can customize your graphs. You can also 
change background colors, use graphics (such as organization logos) for backgrounds, rotate graphs, 
change lighting and otherwise edit your graphs to make them unique.

____________________________________________________

Variable Width Graph
The next tool on the list is the Variable Width Graph. The Variable Width Graph is a representation 
of turning movement data using thick and thin lines to show volume differences – the thicker the 
line, the higher the volumes.

To access this feature, go to 
the Tools menu, select Vari-
able Width Graph and the 
graph window will appear. 
Note that you can also access 
this screen by clicking on the 
Variable Width Graph icon.

The left side of the screen 
displays the data, with arrows 
showing the direction the 
traffic is moving. The thick 
lines represent the heaviest 

traffic volumes while the thin lines represent the lightest volumes.

At the top right, the Select Approaches field is used to determine what approach data will be used 
for the display. Click on the box next to Main St. – From North and notice that the volumes for this 
approach disappear. Reclick the box to put the data back.

Note that in this field the data for the approach listed at the top appears in the forefront of the display, 
while the data for the approach listed at the bottom appears at the back of the display. The order 
in which the approaches are listed can be changed by clicking on an approach then clicking on the 
arrow to the right.

The Select Groups field works in the same manner. Click on the box next to Trucks and notice that 
the overall volumes go down. Also notice that the list of groups in the center of the screen gets up-
dated to show that the Trucks are no longer being shown with the data. Reclick the box to put the 
data back.

The Select Colors field is used to pick what colors will be used to represent each approach’s data, 
as well as the background and text colors. To change a color, click on the button representing the 
direction of traffic you want to affect and you can choose an existing color or define a custom color.  
This can also be done for the background of the plot by clicking on the large button in the lower left 
and for the text used in the plot by clicking on the Text Color button.

Figure 5-28: 
Variable 

Width Graph
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The current black background of the plot makes it a little difficult to see some of the information, so 
let’s change it. Click on the background button and pick one of the dark gray colors. Once you’ve 
selected the color, click OK and the display will update to show the change.

The Select Times field is used to pick a specific time period within the data to be plotted. The de-
fault selection uses the start and end times of the study, but by clicking on the arrows in either the 
From or To boxes you can choose any time period. Change the To field to 6:45 AM and the volumes 
change accordingly.

Notice, however, that the line widths do not change dramatically. This is because the width of each 
line is always in relation to the widths of the other lines in the plot. The From East through move-
ment volumes went from 5475 when we showed all the data to 225 when we showed just the first 
hour, but the width of the line did not change much, if at all. This is because the volumes for all the 
other movements were also reduced. Generally, if the line widths do not change appreciably when 
you show different portions of the data, it is an indication that the volumes of the movements are 
uniform, in relation to each other, throughout the day.    

The Variable Width Graph can be printed directly from this screen, or included with a larger report. 
How you included it with a larger report will be covered in the next lesson. You can also copy the 
plot for pasting in other programs, like Word or Excel, by clicking the Copy button.

If you want to print the plot 
by itself you can do so by 
clicking on the Preview/
Print button. Click this but-
ton and the print setup for the 
plot will appear. The Report 
Headings field is used to 
select a title for the printout 
from the list of titles created 
in the Titles tab of the Pref-
erences. The Options field 
is used to select whether 
you want to print Headings 

and Comments with the plot. The Plot Size slider bar is used to adjust the size of the plot for the 
printout. Once these are set, click the Preview/Print button again and a print preview of the plot 
will appear.

This screen shows a preview of how the plot will look when printed. You can send the plot to your 
printer, or save it in an electronic format as a PDF or Rich-Text file.
 
We won’t bother to print the plot now, so click on the Close button to close the preview and the 
print setup, then click the Quit button to return to the main data screen. Click the Save icon to save 
the changes you’ve made.

Note that the Variable Width Graph is not available for files with diagonal approaches, such as 
Southwestbound, Northeastbound, etc. It can only be used for files with standard North, South, East 
or West approaches.

____________________________________________________

Figure 5-29: 
Print

Settings

Chapter 5 — Learning the Basics of PETRAPro, Part 2



PETRAPro Reference Manual

22

Change 
Interval
 Length

The next Tool in the list is Change Interval Length. This can be used to combine data intervals in your 
file to show the data in a larger time frame. To see how this works, we'll use it with our sample file, 
which uses 15 minute intervals. Go to the Tools menu and slide down to Change Interval Length. 
Select 60 Minutes from the list and notice that our file, which did have 48 15-minute intervals, has 
been converted to 12 60-minute intervals. We don't want to keep this change, so use the Undo op-
tion to reset the file.

Note that the only options available when we went to the Change Interval Length selection were 30 
and 60 Minutes. The 5 and 15 Minute options were disabled. This is because you can only change 
the interval length of your file to a larger value, not a smaller one. Since the data in our file is already 
stored in 15 minute blocks, the program does not know what portion of the volume in that 15 minute 
block was from the first 5 minutes, the second 5 minutes or the third 5 minutes. It only knows that 
the volume occurred at some point during the 15 minute block.

____________________________________________________

Earlier in this tutorial we saw how we could attach a digital photo of the data collection site to our 
data file. Now we'll see one of the options we have for getting these photos. The final tool in the list 
is Online Map. This tool lets you access the free web-based mapping applications Google Earth and 
Windows Live Local from your data file.

Google Earth and Windows Live Local are competing programs that in essence do the same thing 
- allow you to see aerial views of the Earth. To use these applications, you must have an Internet 
connection on your computer, and GPS coordinates stored in your PETRAPro file.

In Lesson 4 of this tutorial, we saw that GPS coordinates can be entered into a PETRAPro file on the 
Edit Header Information screen. The sample file we are working with has these coordinates already 
stored. We'll now use these coordinates to access a map of the data collection site.

The first application we’ll look at is Google Earth. This application requires that you download and 
install a portion of it from the Google web site. If you plan to use Google Earth with PETRAPro, 
or want to follow along on your computer with this tutorial, download the free version of Google 
Earth now at: http://earth.google.com/.

Once Google Earth has been installed on your computer, you can start it by going to the Tools menu, 
sliding down to Online Map and selecting Google Earth. Note that you can also access this feature 
by clicking on the Google Earth icon in PETRAPro’s toolbar.

Google Earth begins with an aerial view 
of the Earth and begins to zoom in to the 
coordinates of your PETRAPro file. It’s 
a pretty cool process to watch. As the 
zoom brings you closer and closer to 
your location you’ll begin to see more 
details. Finally the zoom will stop, 
around 1500 ft. above the coordinates 
of your PETRAPro data file.

Google Earth contains a number of 
different tools that you can use when 
viewing your map. The ‘Layers’ check-
list lets you choose what information to 
include on the map you see. The ‘Tilt’ 

Online
Mapping

Figure 5-30: 
Google Earth 

Aerial View
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commands can be used to tilt your view for the map up or down while the ‘Rotate’ commands can 
be used to change your perspective. The ‘Zoom’ commands can be used to zoom farther out or closer 
in to your coordinates.

Once you have the map set to show what you want, you can save a copy of it for use in your PETRAPro 
file by selecting ‘Save Image’ from the File menu. The picture you saved can then be added to the 
Intersection Geometry in PETRAPro, as we did earlier in this lesson. Exit out of Google Earth once 
you are done playing with it.

The Windows Live Local application is very similar to Google Earth in that it provides aerial views 
of the Earth. Unlike Google Earth, this application does not require any program to be downloaded 
and installed on your computer, so to start it, go to the Tools menu, slide down to Online Map and 
select Windows Live Local. Note that you can also access this feature by clicking on the Windows 
Live Local icon in PETRAPro’s toolbar.

Once you start Windows Live Local, it 
takes you directly to an aerial view of 
your coordinates. Like Google Earth, 
Windows Live Local has a few tools that 
can be used when looking at the map. 
A slider bar can be moved to zoom out 
from your location or zoom in.

For some locations, Google Earth has 
better images and for some Windows 
Live Local has the edge.

At the time this tutorial was written, 
Google Earth appears to have an advan-
tage over Windows Live Local in that 

the maps you create with Google Earth can be saved as a graphic and used in PETRAPro. However, 
these are both fairly new applications that are sure to evolve and improve as time goes by.

____________________________________________________

Congratulations! You have completed lesson five. In this lesson we learned how to use some of the 
Tools in PETRAPro. In the next lesson we’ll learn how to produce a report from the data. You can 
take a break now, or jump right into the next lesson.

Figure 5-31: 
Windows 

Live Local 
Aerial View
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Lesson 6 — Producing a Report
Once you have edited a data file to your liking, you are most likely going to want to produce a report 
containing the data. For this lesson, we’ll produce a report from the data contained in the Sample File 
- Standard Turning Movement. If you already have this file open on your screen, you’re set to go. If 
not, retrieve it now. If you’re not sure how to do this, refer to Chapter 4, Lesson 3 for instructions.

To begin the report creation process, click on the File menu and select Print. This will open the Turn 
Print Setup screen. Note that you can also access this screen by clicking on the Print icon.

There are seven separate tabs on this 
screen that can be used to set up a re-
port for printing. The first of these is the 
General tab. This tab allows you to pick 
the times for the report and set some 
other options that will determine how 
the data is printed.

At the top left is the Select Interval 
Length field. If you want to see the data 
presented in different interval lengths 
you can use this field. Two other options 
are No Data and Grand Total. Select 
No Data if you do not want to see the 
actual count data. This can be useful if 
you only want to produce a peak report 

or an intersection plot. Select Grand Total to see the totals for the entire count without an interval 
break down. The most commonly used interval length is 15 minutes, so that’s what we’ll use. Set 
this field to 15 Minutes.

Below the Select Interval Length field is the Empty Intervals field. This is used to determine how 
the report should deal with intervals that contain all zeroes. This most often occurs when you collect 
data at specific times of a day (AM peak, PM peak, etc.) rather than continuously. If the Hide Empty 
Intervals box is not checked, the report will include intervals with all zeros in the report. If the box 
is checked, the report will replace the empty intervals with whatever is entered in the Wording box.  
‘Break’ is the default setting but this may be changed to any wording desired. The data in our sample 
file is continuous, so we don’t have to worry about this.

To the right of the Select Interval Length field is the From - To field. This field lets you select the time 
period for the report. It is defaulted to use the start and end times of the data, but you can change 
these if you don’t want to print all of the data. We’re going to use all the data in the sample file, so 
leave the default times alone.

Below the From - To field is the Options field. This is a very important field because it allows you to 
include a variety of features with the report. Any items that are checked will be included. Unchecked 
items are not included.

The first item on the list is Approach Totals. If this is checked an extra column of data is added to 
each approach in the report and shows the total for that approach. This can take up a lot of space, 
so unless you specifically need this information we recommend leaving this box unchecked. We’ll 
leave it unchecked for this lesson.

Figure 5-32: 
Turn Print 

Setup -
General tab
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The second item on the list is Print Comments. If this is checked, the Comments that were entered in 
the header for the file will be printed in the upper left corner of the report. Refer to the Edit Header 
portion of Lesson 4 for more information on this. Since we took the time to enter these comments, 
we might as well print them. Place a check in this box.

The third item on the list is Print Peaks. If this is checked, the program will look for peak infor-
mation based on what has been entered in the Peak tab. Place a check in this box. We’ll see how the 
peak tab works in a minute.

The fourth item on the list is Plot Totals. If this is checked, the report will contain a standard inter-
section plot of the overall data. We want to include this, so place a check in the box.

The fifth item on the list is Intersection Drawing. If this is checked, the report will include a copy of 
the Intersection Geometry that was setup using the Intersection Design tool, as discussed in Lesson 
5. Since we set this up in Lesson 5, place a check in the box.

The sixth item on the list is Intersection Photo. If this is checked, the report will include a copy of 
any digital photo that has been included with the file. Since we set this up when using the Intersec-
tion Design tool in Lesson 5, we'll include it. Place a check in the box.

The seventh item on the list is Graph Totals. If this is checked, the report will include a copy of the 
Variable Width Graph, which we covered in Lesson 5. Place a check in this box as well.

The eighth item is Do NOT Print Headings. This allows you to produce a report without headings 
in the top middle of the report. We're going to see how these headings work a little later, so leave 
this box unchecked.

To the right of the Options field is the Combine Groups field. This fields lets you select which groups 
you want to include in the report. We’re going to print both group 1 (Passenger Vehicles) as well as 
group 2 (Trucks), so leave both groups checked.

Now that we have the General tab fin-
ished, lets move to the next one – Peaks. 
Click on the Peak tab.

This tab is used to set up the peak infor-
mation you wish to include in the report.  
There are several standard peak settings 
that can be accessed by clicking on the 
list box at the top of the screen, such as 
1 Peak - Whole Count, 2 Peaks – 1 AM 1 
PM, 3 Peaks – 1 AM 1 Noon 1 PM, etc. 
Or, you may set the peak information 
for any amount and times that you like. 
We’re going to look for just one peak, so 
set the box as 1 Peak – Whole Count.

The # column at the far left of the screen allows you to look for multiple peaks within the time listed 
on that line. We only want one, so leave the default setting.

Figure 5-33: 
Turn Print 

Setup -
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For each peak that is programmed, you are also given several options as to how the data should be 
presented when printed out. To select an option, click on the box shown below it and a check mark 
will appear. The options are: 

By Approach  Select this option to have the program determine the peak hour on an ap-
proach by approach basis.

By Intersection  Select this option to have the program determine the peak hour based on 
the entire intersection total. The largest hour(s) will determine the peak, 
with no regard taken for individual approaches.

New Page  Select this option to force a page break to occur before printing the peak 
analysis.

Plot  Select this option to include an intersection plot of the peak data in the 
report.

Graph Select this option to include a Variable Width Graph of the peak informa-
tion.

The most common way of looking for peak information is By Intersection, so check the box for 
that. We want our peak information to start on a new page, so check the New Page box. We won’t 
bother with a plot or graph, so leave these unchecked.

At the bottom left of the screen are two additional options, Show the group breakdowns on peak 
report and Show highest peaks in bold for each group. If the first option is selected, peak volumes 
will be reported for each group of data, as will the percentage of each group. If the second option is 
selected, the highest interval volumes for each movement and approach will be shown in bold. We 
want to see both of these, so put a check in each box.

Note that the settings you select in the Peak tab will not be used unless you have checked off Print 
Peaks in the Options field of the General tab.

Now that the Peak information is set, 
let’s take a look at the next tab. Click 
on the Comments tab. This tab allows 
you to include a variety of information 
printed with your data.

Does the information in the Count 
Comments field at the upper left look 
familiar? It should – we entered these 
comments using the Edit Header in les-
son 4. You can use them the way they 
are, or you enter new ones directly on 
this screen. We’ll leave them the way 
they are.

You are also given the option of where 
you want to have them printed: Top of first page only, Bottom of last page only or Top of each page. 
We’ll use the default setting of Top of each page.

The other four tabs of this screen (Before Data, After Totals, At End of Report) are used to enter 
additional information for the report. These can be used to provide additional written information 
with your report. We aren’t going to add any additional information, so we won't need to use these 
tabs.

Figure 5-34: 
Turn Print 

Setup -
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The next tab is the Factors tab. Click 
on it to bring it up on the screen. This 
screen works in much the same way as 
the Factors tool that we covered in Les-
son 5. The difference, however, is that 
using factors here does not change your 
original data; it only changes it on the 
report itself.

This tab also gives you the option of 
applying your factor to individual ap-
proaches. To do this you place a check 
in the Apply field for each of the ap-
proaches you wish to have the factor 
used on.

Another option found on this tab is the ability to print the factor with the report. You do this by 
checking the Print Correction Factor on Report box.

We aren’t going to apply any factors to our report, so leave the factors with the 1.000 defaults.

Note that when a factor other than 1.000 has been programmed, an asterisk (*) will appear on the 
Factor tab to let you know that a factor is going to be used in the report.

The next tab, Page, is used to select the Printer you want to use and set some of the physical char-
acteristics for the report. Click on this tab.

The Current Printer Setup field at the 
top of the screen provides information 
on the currently selected printer. To 
choose a different printer, click on the 
‘Setup’ button.

The Orientation field allows setting your 
printout for either Portrait or Landscape, 
while the Margins field allows you to set 
the margins that will be used with the 
printout. Generally, you want the mar-
gins to be small enough so that there is 
enough room to print the actual data, 
but do not set them to zero otherwise 
information may get cut off. A setting of 
.25 is usually a good compromise.

To the right of the Margins field is the Line Spacing field. This allows you to set the spacing that will 
be used between each interval of data. The default setting is for single spacing, but can be changed 
to 1.25, 1.50, 1.75 or double spacing.

The final field on this tab is the Preview. This shows how the currently selected orientation and 
margins will appear in the printout. Change the Orientation from Portrait to Landscape, then back 
again. Notice that the Preview updates each time to show the change.

Figure 5-35: 
Turn Print 

Setup -
Factor tab

Figure 5-36: 
Turn Print 

Setup -
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Chapter 5 — Learning the Basics of PETRAPro, Part 2



PETRAPro Reference Manual

28

Now click on the Headings tab. 

The Report Headings field is used to 
pick the title that will be printed at the 
top of each page in the report. Notice 
that the default titles are the ones we 
entered in the Preferences in Lesson 
1. If you create multiple sets of titles 
in the Preferences, you can choose the 
ones you want using the Previous and 
Next buttons. For this report, we’ll use 
the default titles.

At the bottom left of the Report Head-
ings field is a preview of the logo to be 
used with the report. This is the logo 
that was set up through the Preferences 

back in lesson 1. On this screen, you can change the size of the logo to make it larger or smaller by 
adjusting the Height and/or Width values.

At the bottom right of the Report Headings field is the Starting Page Number field. This field gives 
you the opportunity to start the page numbering at something other than the number 1. This feature 
would generally be used if you were planning to use the report as part of a larger document, or with 
other reports produced in PETRAPro. For this report, we’ll leave it set for 1.

Now click on the final tab, Exclude.

This tab is used to exclude movements 
from different areas of the report.  Move-
ments can be excluded from the entire 
report, from the totals, or from peak 
analysis.  To exclude a movement, find 
the appropriate row and check off the 
boxes for the approaches from which 
you wish to have the movement excluded.  
The Toggle Selected button will reverse 
the currently selected setting while the 
Reset Button will clear all settings.

When movements are excluded from the 
Totals, they will still be printed on the 
report. However, you can use the Exclude 
From Totals Format function to choose a 

style in which these numbers are displayed so they can be distinguished from the movements that 
are being included in the totals. Also note that if a movement is excluded from the Totals it is auto-
matically excluded from the Peak as well.

When movements have been excluded, an asterisk (*) will appear on the Exclude tab. We aren’t 
going to exclude any data from our report, so don’t check any boxes.

Now that we’re finished setting the report up, we want to see how it is going to look and decide how 
we are going to output it. Click on Preview.

Figure 5-38: 
Turn Print 

Setup -
Exclude tab

Figure 5-37: 
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Once you click on Preview, the Print Preview screen will appear. This screen allows you to see how 
the finished report will look.

When the preview screen first 
appears, you may not be able to 
see the report clearly. To zoom 
in for a closer look, double 
click your mouse anywhere 
on the preview screen. You can 
zoom in closer by continuing to 
double click your mouse. If you 
get too close, you can zoom out 
by double clicking your right 
mouse button.

The options listed with the 
Magnifying glass button can 
also be used to get a different 
look at the report. The Whole 
Page selection shows a com-
plete page in the preview. This 

is the default selection when the preview first appears. The Page Width selection will zoom in on the 
report until it fits the entire width of the preview screen. Click on this selection to see how it looks. 
The Two Pages selection will do just what is says, show two pages at a time in the preview. Click 
on this selection to see how it looks. The Thumbnail selection provides small pictures of each page 
of the report. Click on this selection to see how it looks. The percentile listings, from 150% to 25%, 
provide different levels of magnification of the report. Click on some of these to see how they work. 
They produce the same affect as double clicking with the mouse’s left and right buttons. Once you 
are done, click back on the Whole Page selection.

To view additional pages of a report when you are in Whole Page view, use the page selection op-
tions found at the upper left of the screen. Click the right arrow of this feature to scroll through the 
various pages of the report.

One of the most useful features of the PETRAPro program is the ability to output your finished 
reports in an electronic format. The two options you have to do this are PDF and RTF.

The PDF option will create a copy of the report in Adobe Acrobat format, a widely used standard 
for the exchange of electronic files. Files created in PDF format can be viewed with the Acrobat 
Reader program, which is available for free from Adobe.

The RTF option will create a copy of the report in Rich Text Format, a text file that allows differ-
ent font styles and colors. Files created in RTF format can be viewed with most word processing 
programs, such as Word or WordPad.

Using either the PDF or RTF report export options, you can create copies of a report that can be 
e-mailed or posted on the Internet. Other people can then view these reports without having to use 
PETRAPro. The main difference between the two formats is that people viewing a PDF file cannot 
change the data, while those viewing an RTF file can.

Save
 Reports 

Electronically

Figure 5-39: 
Report 

Preview
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Now that we are finished previewing the report, it’s time to print it out. To do this, click on the Print 
button. This will bring up the standard Windows print setup screen where you can choose the printer 
you want to print to. Keep in mind that reports from PETRAPro can be printed in color if you have 
a color printer. Once you have selected your printer, send the report to it.

Congratulations! You have completed lesson six. In this lesson you learned how to produce a report 
from a data file. This lesson concludes the tutorial for learning the basics of PETRAPro. You should 
now have a good working knowledge of how to use the program.
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 Turning Movement Files

Once a Turning Movement study is open in the program, there are a number of things that can be 
done to edit or adjust the file. Each file appears in its own window in the program; you may have 
more than one file open in the program at a time.

Turning Movement files contain six main areas of information: the Header Information, Approach 
Descriptions, Movement Descriptions, Group Names, Interval Times and Data Grid. These area 
are shown in the figure above. 

Standard Turning Movements are collected with 3 or less Group tabs. Enhanced Turning Movement 
files can have up to 16 separate groups of data.

The information contained in the file can be adjusted and modified in several ways using the Toolbar 
and Menu Options, shown above. How these functions work are covered in detail in Chapters 4 
& 5.
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 Interpreting Turning Movement Reports
Turning Movement reports can be produced with a number of different options either included or 
excluded. The following sections cover the various options that can be used. Your reports may not 
include all of these options but they will contain some of them.

This area of the report contains all the data that was collected for the study. Generally the data is in 
15-minute intervals, although it can also be done in 1, 5, 30, and 60-minute intervals.

The data is listed in chronological order with each interval’s start time or end time displayed, de-
pending on what option has been selected in the Preferences. Which groups of data are being shown 
is listed at the top of the report on the Groups Printed line.

At the end of the data, Grand Totals are provided for each movement, and each column is broken 
down into what percentage of the approach it is and what percentage of the overall data it is.

If more than one group is included in the report, a breakdown is provided for each group of data, 
including volume totals for each group, and what percentage each group is of the overall total. 

If the Plot Totals box is checked in the Options 
field of the General tab of the Turn Print Setup, 
an intersection plot of the overall data will be 
produced with the report.  This is a graphical 
depiction of the data showing the Inbound and 
Outbound totals for each approach to the inter-
section.

The middle of the Intersection Plot contains a 
North arrow as well as a box listing the beginning 
and ending times of the data shown and what 
groups are being shown.

Note that In and Out listing are always in refer-
ence to the intersection itself. Refer to Chapter 
13 for a more detailed explanation of this. 

Overall 
Data

Figure 6-2: 
TM Report - 
Overall Data
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If the Graph Totals box is checked in the Options 
field of the General tab of the Turn Print Setup, 
a variable width graph of the overall data will 
be produced with the report. This is a graphical 
depiction of the data that uses lines of varying 
width to show volume differences — the thicker 
the line, the higher the volume.

The middle of the graph lists the beginning and 
ending times of the data shown and what groups 
are being shown.

Peak analysis information will be printed with a report if the Print Peaks box is checked in the Op-
tions field of the General tab of the Turn Print Setup. The Peak tab of the Turn Print Setup is used 
to set the parameters for the peak analysis. Refer to chapter 5 for more information on setting up 
peak information for reports.

The first line of the analysis says ‘Peak Hour From’ and lists the start and end time that was picked 
for the analysis. It also lists whether one or more peaks are being looked for in this time period. 
The second line lists whether the analysis is for the Entire Intersection or By Approach and lists the 
actual starting time of the peak hour.

The next four lines list the actual volumes for the peak hour, with the high interval volume of each 
column in bold. This is followed by each movement's total volume for the peak hour, and what 
percentage it is of the approach.

The next line list the PHF, or Peak Hour Factor, for each column of data. (Note that the overall PHF 
is not provided for peaks done By Approach.) Refer to the Appendix for more information on how 
the Peak Hour Factor is calculated.

Following the PHF information is optional group breakdown information. If the Show the group 
breakdown on peak report option has been selected in the Peak tab, this area will show the peak 
volumes on a group by group basis, as well as a percentage breakdown. 

Figure 6-4: 
TM Report - 
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TM Report - 

Peak Analysis



5
If a plot of the peak data has been requested in the Peak tab of the Turn Print Setup, an intersection 
plot of the peak data will follow the regular peak analysis. This plot is similar to the one described 
earlier for the overall data. Note that By Approach peak plots will only show Inbound volumes as 
the Outbound volumes would vary due to the different peak times of each approach.

If a graph of the peak data has been requested in the Peak tab of the Turn Print Setup, a Variable 
Width graph of the peak data will also be produced with the report. 

If the Intersection Drawing box is checked in the 
Options field of the General tab of the Turn Print 
Setup, a graphical depiction of the intersection 
where the data was collected will be included 
with the report.

The Intersection Drawing can be created or 
edited using the Intersection Design selection 
of the Tools menu. Refer to Chapter 5 for more 
information on how to design an intersection 
with this tool.

If the Intersection Photo box is checked in the Options field of the General tab of the Turn Print 
Setup, any digital photo you have attached to the file will be included with the report.

Digital photos can be attached to a file using the Intersection Design selection of the Tools menu. 
Refer to Chapter 5 for more information on how to include a digital photo with your data.

Chapter 6 — Turning Movement Files & Reports
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 Roundabout Movement Files

Once a Roundabout Movement study is open in the program, there are a number of things that can 
be done to edit or adjust the file. Each file appears in its own window in the program; you may have 
more than one file open in the program at a time.

Roundabout Movement files contain six main areas of information: the Header Information, Ap-
proach Descriptions, Movement Descriptions, Group Names, Interval Times and Data Grid. These 
area are shown in the figure above. 

The information contained in the file can be adjusted and modified in several ways using the Toolbar 
and Menu Options, shown above. Editing options for Roundabout files are identical to those for 
turning movement files. How these functions work are covered in detail in Chapters 4 & 5.
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Chapter 7 — Roundabout Movement Files & Reports

Roundabout Movement reports can be produced with a number of different options either included 
or excluded. The following sections cover the various options that can be used. Your reports may 
not include all of these options but they will contain some of them.

This area of the report contains all the data that was collected for the study. Generally the data is in 
15-minute intervals, although it can also be done in 1, 5, 30, and 60-minute intervals.

The data is listed in chronological order with each interval’s start time or end time displayed, de-
pending on what option has been selected in the Preferences. Which groups of data are being shown 
is listed at the top of the report on the Groups Printed line.

At the end of the data, Grand Totals are provided for each movement, and each column is broken 
down into what percentage of the approach it is and what percentage of the overall data it is.

If more than one group is included in the report, a breakdown is provided for each group of data, 
including volume totals for each group, and what percentage each group is of the overall total. 

If the Plot Totals box is checked in the Options field of the General tab of the Turn Print Setup, an 
intersection plot of the overall data will be produced with the report.  This is a graphical depiction 

of the data showing the Inbound and Outbound 
totals for each approach to the intersection.

The middle of the Intersection Plot contains a 
North arrow as well as a box listing the beginning 
and ending times of the data shown and what 
groups are being shown.

Note that In and Out listing are always in refer-
ence to the intersection itself. Refer to Chapter 
15 for a more detailed explanation of this. 
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If the Graph Totals box is checked in the Options 
field of the General tab of the Turn Print Setup, 
a variable width graph of the overall data will 
be produced with the report. This is a graphical 
depiction of the data that uses lines of varying 
width to show volume differences — the thicker 
the line, the higher the volume.

The middle of the graph lists the beginning and 
ending times of the data shown and what groups 
are being shown.

Peak analysis information will be printed with a report if the Print Peaks box is checked in the Op-
tions field of the General tab of the Turn Print Setup. The Peak tab of the Turn Print Setup is used 
to set the parameters for the peak analysis. Refer to chapter 5 for more information on setting up 
peak information for reports.

The first line of the analysis says ‘Peak Hour From’ and lists the start and end time that was picked 
for the analysis. It also lists whether one or more peaks are being looked for in this time period. 
The second line lists whether the analysis is for the Entire Intersection or By Approach and lists the 
actual starting time of the peak hour.

The next four lines list the actual volumes for the peak hour, with the high interval volume of each 
column in bold. This is followed by each movement's total volume for the peak hour, and what 
percentage it is of the approach.

The next line list the PHF, or Peak Hour Factor, for each column of data. (Note that the overall PHF 
is not provided for peaks done By Approach.) Refer to the Appendix for more information on how 
the Peak Hour Factor is calculated.

Following the PHF information is optional group breakdown information. If the Show the group 
breakdown on peak report option has been selected in the Peak tab, this area will show the peak 
volumes on a group by group basis, as well as a percentage breakdown. 
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If a plot of the peak data has been requested in the Peak tab of the Turn Print Setup, an intersection 
plot of the peak data will follow the regular peak analysis. This plot is similar to the one described 
earlier for the overall data. Note that By Approach peak plots will only show Inbound volumes as 
the Outbound volumes would vary due to the different peak times of each approach.

If a graph of the peak data has been requested in the Peak tab of the Turn Print Setup, a Variable 
Width graph of the peak data will also be produced with the report. 

If the Intersection Drawing box is checked in the 
Options field of the General tab of the Turn Print 
Setup, a graphical depiction of the intersection 
where the data was collected will be included 
with the report.

The Intersection Drawing can be created or 
edited using the Intersection Design selection 
of the Tools menu. Refer to Chapter 5 for more 
information on how to design an intersection 
with this tool.

If the Intersection Photo box is checked in the Options field of the General tab of the Turn Print 
Setup, any digital photo you have attached to the file will be included with the report.

Digital photos can be attached to a file using the Intersection Design selection of the Tools menu. 
Refer to Chapter 5 for more information on how to include a digital photo with your data.
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 Stop Sign Delay Files

Figure 8-1: 
Stop Sign 

Delay File

Once you have opened a Stop Sign Delay file in the program there are several things that can be 
done to edit or adjust the file. Each file appears in its own window in the program; you may have 
more than one file open in the program at a time.

Stop Sign Delay files contain five main areas of information: the Header Information, Vehicle Num-
ber, Data Grid, Graph and Quick Analysis. These are shown in the figure above.

In a stop sign delay file each vehicle recorded is listed, along with the time it entered and left the 
queue, total time in the queue and a graphical representation of the time in queue. These numbers are 
used to calculate the values that are shown on the screen in the quick analysis. In the quick analysis, 
a numerical value can be typed in for the Min. Secs for Delay. The program will use this number 
in determining how long a vehicle had to stop in order to be considered delayed.

For example, if two seconds is entered the program will consider any vehicles that had to stop for 
zero or one seconds as not having been delayed. An example of this would be a vehicle doing a 
‘rolling’ stop where it was recorded as leaving the queue immediately after entering it.  

The information contained in the file can be adjusted and modified in several ways using the Toolbar 
and Menu Options, shown above. These functions work in much the same way as they do for turning 
movements files. Refer to Chapters 4 & 5 for more information.
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 Interpreting Stop Sign Delay Reports
Stop Sign Delay reports are set up in a manner very similar to Turning Movement reports. Refer 
to Chapter 5 for more details. Reports can be produced with a number of different options either 
included or excluded. The following sections cover the various options that can be used. Your reports 
may not include all of these options but they will contain some of them.

This area of the report contains all the data that was collected for the study on a vehicle by vehicle 
basis. The data is listed in chronological order, with data from lane one listed first followed by data 
from lane two, if more than one lane was studied.

The times at which the vehicle joined and left the queue are listed, as well as the time delayed, in 
seconds. If Graph Totals has been selected in the Options field of the General tab of the Stop Sign 
Delay Print Setup, then a bar graph representing the delay time will also be printed. The color used 
for the bar graph can be changed using the Graph Color button in the Options field.

The wording for Lane 1 and Lane 2 can be changed using the Edit Count Header tool.

The Statistical Summary can be produced for every 1, 5, 10, 15, 30 or 60 minutes of the data, or 
for all the data. This summary provides a breakdown of the overall data into a number of statistical 
categories for one or two lanes, depending on how many were included in the study.

Start - End Times – This line lists when the first and last vehicles of the study were recorded.

Total Vehicle Count – This line lists the total number of vehicles recorded in the summary 
period.

Delayed Vehicle Count – This line lists how many vehicles had to stop at the stop sign for a 
period longer than has been entered for the Minimum Seconds for Delay.  Refer to the previous 
page for more information on how to enter this value.

Chapter 8 — Stop Sign Delay Files & Reports
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Through Vehicle Count – This line lists how many vehicles had to stop for less than the time 
entered for the Minimum Seconds for Delay and are therefore not considered to be delayed.

Average Stopped Time – This line provides the average amount of time a vehicle had to wait 
at the stop sign.

Maximum Stopped Time  – This line lists the longest time a vehicle had to wait at the stop 
sign.

Minimum Seconds for Delay – This is the value that has been entered in the file in the Min. 
Secs. for Delay field and is used in determining the Through and Delayed Vehicle Counts men-
tioned above.  Refer to page 8.2 for more information on how to set this value.

Average Queue – To arrive at the average queue, the program scans through the data and, for 
each second, computes the number of vehicles waiting at the intersection (queue size) and adds 
it to the “total queue”. This total is then divided by the total number of seconds in the study 
(stop time - start time).

Queue Density – This value is calculated in a manner similar to Average Queue, with the ex-
ception that seconds where the queue is zero are not counted in total time. In other words, this is 
the average size of the queue when there was a queue. By looking at the Average Queue and Queue 
Density together you can determine the amount of platooning occurring at the intersection. The 
closer these two numbers are, the more evenly the traffic is arriving at the intersection. A large 
difference in these two numbers would indicate that vehicles are arriving in larger platoons.

Maximum Queue – This line gives the largest queue that existed during the summary period.

Stop Sign Delay reports can also contain a printout of the Intersection Drawing and/or Intersection 
Photo. Refer to chapter 6 for more information on this.  
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 Signalized Intersection Delay Files

Once you have opened a Signalized Intersection Delay file in the program there are several things 
that can be done to edit or adjust the file. Each file appears in its own window in the program; you 
may have more than one file open in the program at a time.

Intersection Delay files contain four main areas of information: the Header Information, Interval 
Times, Data Grid and Quick Analysis. These are shown in the figure above.

For each interval, the Stopped and Through totals are shown, which are then summed in the Total 
Volume column. The Stopped at End of Interval column lists the number of vehicles that were en-
tered into the data collector as being in the queue. These numbers are used to calculate the values 
that are shown on the screen in the Quick Analysis.

The information contained in the file can be adjusted and modified in several ways using the Toolbar 
and Menu Options, shown above. These functions work in much the same way as they do for turning 
movements files. Refer to Chapters 4 & 5 for more information.
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 Interpreting Signalized Intersection Delay Reports
Signalized Intersection Delay reports are set up in a manner very similar to Turning Movement 
reports. Refer to Chapter 5 for more details. Reports can be produced with a number of different 
options either included or excluded. The following sections cover the various options that can be 
used. Your reports may not include all of these options but they will contain some of them.

This area of the report contains all the data that was collected for the study. The data can be collected 
with an interval length of between 10 and 16 seconds. The data is listed in chronological order with 
each interval’s start time or end time displayed, depending on what option has been selected in the 
General tab of Preferences. A Direction Description is listed at the top of the report if one has been 
entered using the Edit Count Header tool.

The first column of data is the Stopped at End of Interval data, which is the number of vehicles in 
the queue at the end of the interval, as entered by the person collecting the data. The second column 
is the Stopped data, which represents the total number of vehicles that had to stop at the intersec-
tion during the interval. The third column is the Through data, which represents the total number of 
vehicles that were able to proceed through the intersection without stopping during the interval.  The 
final column of data is the Total Volume, which is a total of both the Stopped and Through vehicles 
in the interval. At the bottom of the data, the Grand Totals of each column are listed as well as the 
total percentage of Stopped and Through vehicles.

The Statistical Summary of the data provides a breakdown of the overall data into a number of statis-
tical categories. The first two lines of the summary give the times of the first and last intervals done 
in the study. This is followed by the sample rate (interval length) chosen for the study, the number 
of samples collected and the total elapsed time of the study.  

Chapter 9— Signalized Intersection Delay Files & Reports
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The Number Stopped entry shows the total number of vehicles recorded as being in a queue at the 
end of an interval. Below this is the Approach Volume, which is broken down into the total number 
of vehicles that had to stop and the total number that were able to pass through the intersection. 
These are then summed as the Approach Total. The next line lists the Total Delay in seconds, which 
is calculated by multiplying the Number Stopped by the Sample Rate value.

The Avg. Delay per Stopped vehicle gives the average delay for a vehicle that had to stop at the inter-
section (Total Delay divided by Approach Volume Stopped). The Avg. Delay per Approach vehicle 
gives the average delay of all approaching vehicles (Total Delay divided by Approach Total). The last 
line gives the percentage of all approaching vehicles that had to stop at the intersection (Approach 
Volume Stopped divided by Approach Total, multiplied by 100).

Peak Analysis information can be included with the report, but only if there is more than one hour 
of data. Otherwise this option is not available.

Signalized Intersection Delay reports can also contain a printout of the Intersection Drawing and/or 
Intersection photo. Refer to chapter 6 for more information on this.
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 Gap Files

Figure 10-1: 
Gap File

Gap files contain data on the number of gaps that occur in traffic, broken down into 15 two-second 
bins. These are: 2-3 seconds, 4-5, 6-7, 8-9, 10-11, 12-13, 14-15, 16-17, 18-19, 20-21, 22-23, 24-25, 
26-27, 28-29 and greater than 29 seconds. These bins cannot be changed. Each file appears in its 
own window in the program; you may have more than one file open in the program at a time.

Gap files contain five main areas of information: the Header Information, Group Names, Gap Bins, 
Interval Times and Data Grid. These are shown in the figure above. The data grid lists the number 
of specific gaps that occurred per interval. For example, in the Gap file shown in the figure above 
there were 33 different gaps of between two and three seconds from 4:30 to 4:45 for the Eastbound 
group. There were 23 different gaps of four to five second, etc.

If more than one direction of gap information was recorded, the Group Name tabs can be used see 
the second direction as well as the combined gap information.

Note that the Combined group is not merely a sum of the two direction. Rather, it is a listing of when  
there was a gap in both directions at the same time. This information is stored in real time while the 
data is being collected in the field.  

The information contained in the file can be adjusted and modified in several ways using the Toolbar 
and Menu Options, shown above. These functions work in much the same way as they do for turning 
movements files. Refer to Chapters 4 & 5 for more information.
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 Interpreting Gap Reports

One feature that is unique to Gap files is the Column 1 Label Tool. This Tool, which can be accessed 
from the Tools menu, is used to change the label of the first column in gap studies. When doing a 
gap study you have the option to also count vehicles. This is not required to get gap information, 
but it can be useful in putting the gap information into perspective.

For example, imagine that at two different locations there were 100 gaps measured, and the aver-
age gap was 10 seconds. Now imagine that at the first location there were 125 cars counted, and at 
the second location there were 2000 counted. Location one is a quiet little street, with fairly steady 
traffic. Location two is much heavier with platoons of cars. Knowing the volumes helps a lot.

However, some people use the count button to count 
other things, such as pedestrians trying to cross during 
gaps. With the Column 1 Label function you can change 
the name of this count column to reflect what it was that 
you actually counted. 

Column 1 
Label

Figure 10-2: 
Edit Column 1 

Label

Gap reports are set up in a manner very similar to Turning Movement reports. Refer to chapter 5 
for more details. Reports can be produced with a number of different options either included or 
excluded. The following sections cover the various options that can be used. Your reports may not 
include all of these options but they will contain some of them.

This area of the report contains all the data that was collected for the study. Generally the data is 
collected in 15-minute intervals, although it can also be done in 1, 5, 30, and 60-minute intervals.

The data is listed in chronological order with each interval’s start time or end time displayed, de-
pending on what option has been selected in the General tab of Preferences. Which directions of 
data are being shown is listed at the top of the report on the Directions Printed line. The names of 
the directions can be changed for each specific file in the Edit Count Header function.

The first column is the count column, and will only contain data if a count was done while the gap 
information was being recorded. The label for this column can be changed using the Column 1 Label 
function, as described previously.

The report lists the number of specific gaps that occurred per interval. For example, in figure 10-3 
above there were 33 different gaps of between two and three seconds from 2:30 to 2:45. There were 
23 different gaps of four to five second, etc. The Int. Total column gives the total number of gaps 
recorded  (note that this number does not include the count data from column one) while the Average 
column lists what bin the average gap for the interval fell into.   

Chapter 10 — Multi-direction Gap Files & Reports
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At the end of the data the total of each gap bin is listed, along with the overall average gap and what 
percentage each bin was of the overall data.

Peak analysis information will be printed with a report if the Print Peaks box is checked in the Op-
tions field of the General tab of the Gap Print Setup. The Peak tab of the Gap Print Setup is used to 
set the parameters for the peak analysis. Note that you can only get peak information for a gap 
study if count information was collected while gaps were being recorded.

The first line of the analysis read Peak Hour From and 
lists the start and end time that was picked for the anal-
ysis. It also lists whether one or more peaks are being 
looked for in this time period. The second line lists the 
starting time of when the peak hour occurred. The third 
line lists the volume for the peak hour. The next two 

lines list the time of the highest interval within the peak hour, and the volume for that high interval.  
The last line gives the PHF, also know as Peak Hour Factor.

Gap reports can also contain a printout of the Intersection Drawing and/or Intersection photo. Refer 
to chapter 6 for more information on this.

Peak 
Analysis

Figure 10-4: 
Gap Report - 

Peak Analysis
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 Classification Files

Figure 11-1: 
Classification 

File

Classification studies can be done in two formats: using the standard Federal Highway Administra-
tion’s (FHWA) Scheme F of thirteen classes, or using a user defined classification scheme. Refer to 
the Appendix for a detailed description of the FHWA’s scheme F.

Whether the file is user defined or FHWA Scheme F, they are edited  in the same manner, the only 
difference being the number of classes used. Each file appears in its own window in the program; 
you may have more than one file open in the program at a time.

Classification files contain four main areas of information: the Header Information, Class Descrip-
tions, Interval Times and Data Grid. These area are shown in the figure above. 

The information contained in the file can be adjusted and modified in several ways using the Toolbar 
and Menu Options, shown above. These functions work in much the same way as they do for Turn-
ing Movements files. Refer to Chapters 4 & 5 for more information.
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 Interpreting Classification Reports

One feature that is unique to Clas-
sification files is the Edit Class De-
scriptions option. This feature can be 
accessed from the Edit menu, or by 
double-clicking on one of the existing 
class definition column titles. It is used 
to enter the descriptions of the classes 
being used. When first opened, the cur-
rent class names are shown and can be 
edited as desired. The Class Schemes 
button expands the window for se-
lecting a previously saved scheme or 
importing a scheme.

You can create a new scheme by click-
ing on the Add button and entering the 

number of bins (up to 32) to use in the scheme, followed by the definitions of each and the descrip-
tion you want to give the scheme. Click the Use button to use the currently selected scheme in the 
active file.

Classification reports are set up in a manner very similar to Turning Movement reports. Refer to 
Chapter 5 for more details. Reports can be produced with a number of different options either in-
cluded or excluded. The following sections cover the various options that can be used. Your reports 
may not include all of these options but they will contain some of them.

This area of the report contains all the data that was collected for the study. Generally the data is 
collected in 15-minute intervals, although it can also be done in 1, 5, 30, and 60-minute intervals.

The data is listed in chronological order with each interval’s start time or end time displayed, de-
pending on what option has been selected in the General tab of Preferences. Which directions of 
data are being shown is listed at the top of the report on the Directions Printed line. At the end of 
the data the total for each class is listed, as well as the percentage it is of the overall data.

Chapter 11 — Classification Files & Reports
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Peak analysis information will be printed with a report if the Print Peaks box is checked in the Op-
tions field of the General tab of the Classification Print Setup. The Peak tab of the Classification 
Print Setup is used to set the parameters for the peak analysis.

The first line of the analysis reads Peak Hour From and lists the start and end time that was picked 
for the analysis. It also lists whether one or more peaks are being looked for in this time period. The 
second line lists the starting time of when the peak hour occurred. The third and fourth lines list the 
volumes for the hour by each class and what percentage they are of the overall peak data. The next 
two lines list the time of the highest interval within the peak hour, and the volumes for that high 
interval. The last line gives the PHF, also know as Peak Hour Factor.

Classification reports can also contain a printout of the Intersection Drawing and/or Intersection 
Photo. Refer to chapter 6 for more information on this.

Peak 
Analysis

Figure 11-4: 
Class Report - 
Peak Analysis
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 Spot Speed Files

Figure 12-1: 
Spot Speed 

File

Once you have opened a Spot Speed file in the program there are several things that can be done to 
edit or adjust the file. Each file appears in its own window in the program; you may have more than 
one file open in the program at a time.

Spot Speed files contain four main areas of information: the Header Information, Class Descriptions, 
Vehicle Number and Data Grid. These are shown in the figure above.

In a spot speed file the speed of each vehicle recorded is listed, broken down into the classes that were 
used during the data collection. For example, in the figure above the first motorcycle recorded was 
travelling at a speed of 35 mph, the second 37, the third 33, etc. By looking at the Vehicle Number, 
you can determine the total number of vehicles of each class. In the figure above, there is a total of 
six motorcycles, eight heavy trucks, etc.

The information contained in the file can be adjusted and modified in several ways using the Toolbar 
and Menu Options, shown above. These functions work in much the same way as they do for turning 
movements files. Refer to Chapters 4 & 5 for more information.

One feature that is unique to Spot Speed files is the Convert to MPH/KPH option. This option, 
which can be accessed from the Tools menu, is used to convert the speed values from miles per hour 
to kilometers per hour, or vice versa.

Convert 
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 Interpreting Spot Speed Reports

Spot Speed reports are set up in a manner very similar to Turning Movement reports. Refer To Chapter 
5 for more details. Reports can be produced with a number of different options either included or 
excluded. The following sections cover the various options that can be used. Your reports may not 
include all of these options but they will contain some of them.

This area of the report contains all the data that was collected for the study on a vehicle by vehicle 
basis. The vehicles are listed in the order in which they were collected. If the speed data was recorded 
for specific classes, each class is listed separately. The data can be shown in either MPH or KPH.

The Statistical Summary can be produced with a number of different categories, depending on what 
has been selected in the Spot Speed Reports. The first column lists which class of vehicle is being 
analyzed while the second column gives the total vehicle count for that class.

Average Speed – This is derived by adding all the individual speeds within each class, and then 
dividing that result by the number of speed samples.

Percentile Speed – Reports can include percentile speeds from 5 to 100 percent in 5 mph in-
crements.  A percentile speed is determined by sorting all the speed samples from slow to fast, 
and then moving up the list to the point where the percentile requested occurs. For example, if 
you were looking for the 85th percentile and had a file with 100 speed samples, the program 
would sort the samples and then take the 85th vehicle from the list, which would be the 85th 
percentile speed. This is the same as saying ‘85 percent of the traffic was traveling at this speed 
or slower’.

Pace Speed – This column represents the largest number of vehicles traveling in a 10 mph 
speed range.  For example, if the pace speed is 26 to 35, then you could say ‘More vehicles were 
traveling 26 to 35 mph than any other 10 mph speed range’.

Overall 
Data

Figure 12-2: 
Spot Speed 

Report -
Overall Data

Statistical 
Summary
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Number/Percent in Pace – Theses columns give the total number of vehicles that were in the 
pace speed range and what percentage this was of the overall data. The lower the percentage of 
vehicles in the pace speed range, the more widely dispersed the speeds in the study are.

Number/Percent of Vehicles Over Speed Limit – Theses columns give the total number of 
vehicles that were traveling over the designated speed limit and what percentage this was of the 
overall data. The Speed Limit value can be entered in the Print Setup screen. 

Spot Speed reports can also contain a printout of the Intersection Drawing and/or Intersection Photo. 
Refer to chapter 6 for more information on this.  
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 Saturation Flow Files

When you first process a Saturation Flow file, a window titled New Count Options will appear with 
several options related to the data.

The Count Identification field at the top provides Start Date, 
Start Time and Site Code information on the file being pro-
cessed.

The Type of Study field allows you to select how the data was 
collected in the field. There are three different ways to collect 
data:

Type 1 provides only saturation flow rates. For this type of data, 
you only need to record the start of the green signal interval 
and when each vehicle crosses the stop bar. If this type of data 
has been collected, the Signal Timings area of the file will only 
show when each green interval began and when each vehicle 
crossed the stop bar. 

Type 2 provides saturation flow rates as well as the timings of 
each signal interval. For this type of data, you need to record all signal interval changes as well 
as when the vehicles cross the stop bar. If this type of data has been collected, you will see the 
timings for all three intervals of a cycle, and when each vehicle crossed the stop bar. 

Type 3 provides saturation flow rates, signal timings and vehicle arrival types. For this type of 
data, you need to record all signal interval changes, when vehicles cross the stop bar and when 
vehicles stop in the queue. If this type of data has been collected, you will see the timings for all 
three intervals of a cycle, when each vehicle crossed the stop bar and when each vehicle stopped 
in the queue. Figure 13-2 shows an example of a Type 3 data file.

PETRAPro will default the selection in this field to either Type 1, Type 2 or Type 3 based on its 
analysis of the data.

The Select Lane Usage field allows you to select how each of the available four lanes was recorded 
during the study. The options are Not Used, Normal Lane or Left Turn Lane. PETRAPro will de-
fault the selection for each lane to one of these options, based on its analysis of the data.

The Ignore Vehicles field allows you to select with which vehicle to start the saturation flow rate 
analysis. The analysis should be based only on vehicles that have a saturation headway, which gen-
erally begins with the fourth or fifth vehicle in the queue.

How the data in a saturation flow is presented in PETRAPro is largely determined by the type of 
saturation flow study you did, and the other options selected in the New Count Options window. 

Figure 13-1: 
Saturation 
Flow New  

Count Options
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Figure 13-2: 
Saturation 
Flow File

Once you have opened a Saturation Flow file in the program there are several things that can be done 
to edit or adjust the file. Each file appears in its own window in the program; you may have more 
than one file open in the program at a time.

Saturation Flow files contain four main areas of information: the Header Information, Signal Timings 
and Lane Information and Display Options. These are shown in the figure above.

The signal timings of each cycle are graphically represented at the top of the file. The timings can 
be adjusted by clicking on one of the traffic signals and dragging the mouse while you hold down 
the mouse button. This is usually done if an error was made during the data collection and the tim-
ings were not recorded correctly.

You can also add a signal by right-clicking in the Signal Timing bar and selecting Add Signal. This 
is usually done if an error was made during the data collection and a signal interval was not recorded 
at all during the data collection. Note that the right-click menu can also be used to ignore or delete 
a signal interval.  

Up to four lanes of traffic are displayed below the signal timings. For each lane, a green time marker 
represents when a vehicle crossed the stop bar during the green interval. Vehicles that are being used 
to calculate the saturation flow rate (usually starting with the fourth vehicle) are a lighter green. A 
red time marker represents when a vehicle stopped in the queue during the red interval.

Vehicle markers can be added or deleted from a lane by right-clicking on the lane. You can also use 
the right-click menu to select (or deselect) vehicles to be used in the saturation flow calculation, 
and to completely delete a lane.

Signal
Timings

Lane
Information
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The Display Options field at the lower left of the screen can be used to change the time scale used 
in the display of data. This field can also be used to toggle the time listed for each vehicle from 
headway (the time, in seconds, from the previous vehicle) to accumulative (the time, in seconds, 
from the start of the signal interval). 

Additional information contained in the file can be adjusted and modified in several ways using 
the Toolbar and Menu Options. These functions work in much the same way as they do for turning 
movements files. Refer to Chapters 4 & 5 for more information.

Display
Options
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 Interpreting Saturation Flow Reports

If Include Individual Cycles has been selected in the Print Setup, the report will contain a statistical 
breakdown of each cycle in the study. Depending on the type of saturation flow study done, this 
breakdown includes:

Arrived on Red - the number of vehicles that arrived during the red interval.
Arrived on Green - the number of vehicles that arrived during the green interval.
Volume - the total number of vehicle that crossed the stop bar during the cycle (arrived on red 
and arrived on green).
Arrival Type - a numerical designation representing the quality of progression. There are six 
types:

Type 1 - Very poor progression, with dense platoons and over 80 percent of volume arriving 
at the start of the red interval.
Type 2 - Unfavorable progression, with moderately dense platoons and between 40 and 80 
percent of volume arriving throughout the red interval.
Type 3 - Random Arrivals, with highly dispersed platoons where the main platoon contains 
less than 40 percent of the volume.
Type 4 - Favorable progression, with moderately dense platoons and between 40 and 80 
percent of volume arriving throughout the green interval.
Type 5 - Highly favorable progression, with dense platoons and over 80 percent of volume 
arriving at the start of the green interval.
Type 6 - Exceptional Progression, with very dense platoons progressing over a number of 
closely spaced intersections.

Lost Time - The time (in seconds) that is lost while the first few vehicles in a queue start up 
to proceed through the intersection when the green interval begins. This value is calculated by 
determining the saturation headway of the cycle (the average headway of all vehicles used to 
calculate the saturation flow rate) then subtracting this value from the headway of the vehicles 
at the start of the queue that were not used to calculate the saturation flow rate. 

Saturation Flow reports are set up in a manner very similar to Turning Movement reports. Refer to 
Chapter 5 for more details. Reports can be produced with a number of different options either in-
cluded or excluded. The following sections cover the various options that can be used. Your reports 
may not include all of these options but they will contain some of them.

Individual
Cycle Data

Figure 13-3: 
Saturation 

Flow Report - 
Individual

Cycle
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# for Sat Flow - the number of vehicles used in calculating the saturation flow rate for the 
cycle
Sat Flow - the saturation flow rate calculated for the cycle. This number represents the number 
of vehicle that could travel through the intersection in one hour if the signal were green for the 
entire hour.

The breakdown is provided for each lane, along with an average for all the lanes and the total for 
all the lanes. The signal timing for the cycle is also provided.

If Print Data as Headway and/or Print Data as Accumulative have been selected in the Print Setup, 
individual vehicle data is provided for these, both when entering the intersection and when joining 
the queue.

If Include Overall Average Summary has been selected in the Print Setup, the report will contain a 
statistical average summary of all the cycles in the study. This summary contains the same type of 
information provided for the Individual Cycle Data listed above.

Summary
Cycle Data
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 Time-Stamped Files

Figure 14-1:
Time-stamped

 File

Once you have opened a Time-stamped file in the program there are several things that can be done 
to edit or adjust the file. Each file appears in its own window in the program; you may have more 
than one file open in the program at a time.

Time-Stamped files contain four main areas of information: the Header Information, Event Number, 
Key Pressed and Time Stamp. These are shown in the figure above.

In a time-stamped file, every key pressed during the study is listed, along with its time-stamp (to 
one-thousandth of a second). The times are offset from the Start Time of the data file. For example, 
in the figure above, the start time of the file is 8:22 AM. The time stamp of the first key pressed (2) 
is 8.518, meaning that the first event occurred at 8:22:08.518.

The information contained in the file can be adjusted and modified in several ways using the Toolbar 
and Menu Options, shown above. These functions work in much the same way as they do for turning 
movements files. Refer to Chapters 4 & 5 for more information.

Note that direct reports cannot be produced from time-stamped data. This data is designed to be 
exported into Excel format for independent analysis. To export the data, go to the File menu, then 
select Export. 
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 Software Updates

For you are having any trouble using your copy of PETRAPro, the first thing we recommend you check is your ver-
sion number. Updates to the program, which contain new features and bug fixes, are issued periodically and posted 
on our web site at www.jamartech.com. To check the version of your program, select About from the Help menu.

 Error Messages

PETRAPro is written in Visual Basic and makes use of the Windows Run Time library. Any unexpected problems 
that occur in the program will usually generate a Run Time Error. These errors are listed by a number, followed by 
a text message. Should you encounter one of these, make a note of the full error message then check the PETRAPro 
support web page at www.jamartech.com/PETRAProsupport.html to see if the error is a known issue.

 Frequently Asked Questions

Are there any known problems with running the program on certain Windows operating systems?
No. The program should run properly on any 98 or higher Windows operating systems, including 98, NT, ME, 2000, 
XP and Vista.

My equipment won’t download to the computer. What’s wrong?
With most computers, downloading your data should be fairly easy. However, if you encounter a problem, check 
the following items.

1. Some devices that are plugged into a serial port will not allow you to download your data properly. These are 
devices that require a program (called a DEVICE DRIVER) to be running in the computer at all times. These device 
drivers are very self-centered, and think that all the data coming into the serial port is for them. Digital cameras, 
Palm Pilots, scanners, power backups, mice, digitizer boards, and light pens are all devices that require these device 
drivers to be running. If you have to unplug a device from the serial port to plug your download cable in, or if you 
are using a switch box, be sure that the device does not have a driver running in memory.

2. Many computers have more than one serial port. You will need to know which serial port you are plugging the 
download cable into. Serial ports are designated as COMx where x is a number from 1 to 16. You will need to know 
this number to download the count board. Consult your computer instruction manual if you have any questions on 
identifying the proper port number.

 Submitting a Support Request

PETRAPro has a built-in form for submitting a support request. Should you encounter an error or experience a problem 
with the program, you can submit a support request using this form if your computer has an Internet connection.

To access this form, go to the Help menu and select Support Request. The Support Request screen will then appear. 
Please fill out the contact information and provide a detailed description of the problem you are having. The support 
form will automatically attach the most recent temporary file from your last download. It will also automatically at-
tach the active data file you have open, so if your problem is related to a specific file, be sure to have the file open.

Once you have completed the support form, click the Send Support Request button and your support request will 
be sent to our support department.
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3. You must correctly identify the type of port you are plugging the download cable into. The 25 and nine pin con-
nectors used for serial (Com) ports are also used for serial or parallel printers, mice, plotters, video cards and other 
devices. Just because your cable fits into a connector on your computer does not mean it is a serial port. Consult your 
computer instruction manual if you have any questions on what ports are serial ports on your computer.

My computer doesn’t have a serial (com) port. What can I do?
Older JAMAR equipment downloads to a computer’s serial (COM) port. If your computer does not have a serial 
port, or if you have a conflict on a serial port, an alternative is to use a USB to Serial Adapter. These devices allow 
you to download data using a USB port as if it were a COM port. A wide variety of these devices are available, 
usually for less than $30. A link to one of these devices can be found on our web site at www.jamartech.com/
hardwaresupport.htm.

The message ‘This file is already marked in use.’ appears when I try to open a file. What does that mean?
This message appears if the file being opened is already open in another window 
or is being accessed from a network drive and has been opened by another user.  
This is to warn the user that someone else may be working on the file at that 
moment.

This message will also appear if the file was open when the program crashed. 
Selecting ‘Yes’ to continue will open the file and it can then be edited.  When the 
file is properly closed, the message will not appear the next time that the file is opened.

You should only answer ‘Yes’ to continue if you know you are the only one working with the file and it was open 
when the program crashed.  Answering ‘Yes’ while the file is open in another window or on another computer will 
result in data loss.

Some of the data in my report does not fit properly and wraps to a lower line. Why?
PETRAPro will always try to fit the information to be printed in the space available. If the program cannot fit a piece 
of information in the space allocated, it will subscript the portion that does not fit onto another line. To avoid this, 
try adjusting the size of the left and right margins to give the report more space. If printing in the portrait mode, try 
using the landscape mode. These changes can be made in the Page tab of the Print Setup.

You may also reduce the font size of the count data or column titles through the Format selection of the main 
menu.

The sides of my report are being cut off. Why?
This can occur on some printers if the margins for the report have been set to zero. To correct this, set the left and 
right margins to a minimum of 0.1. This can be done in the Page tab of the Print Setup.

Data Subscripting Normal Format
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The In and Out totals on the intersection plot appear 
reversed. Are they?
No. The In and Out listing of the Intersection plot are always 
in reference to the intersection itself.

 A vehicle is considered to be going In to the intersection 
from an approach or travelling Out of the intersection to 
an approach. As a result, each vehicle is counted twice in 
the plot.  Once as it enters IN to the intersection, and once 
as it exits OUT of the intersection.

In the figure to the right, the Thru total of 25 of Park Ave. 
southbound is counted as part of the southbound IN to-
tal, since the vehicles are entering IN to the intersection. 
However, the 25 is also counted as part of the OUT total 
(along with the eastbound Right and westbound Left) of 
the northbound approach since it is travelling out of the 
intersection to this approach.

How do I get data into other programs?
There are several ways to transfer data from PETRAPro into other programs. The easiest way is to use the Windows 
Copy and Paste commands. PETRAPro supports these commands so data can be easily moved out of (or into) the 
program.

PETRAPro also contains an Export function that allows data to be saved in several formats, including Excel, AAP 
(for import into other traffic programs like Synchro) and delimited ASCII. Refer to the appendix for more informa-
tion on how the export function works. 

Entering In to the intersection 
from an approach

Exiting Out of the intersection 
to an approach



1

Appendix

Appendix



PETRAPro Reference Manual

2

Installing USB Drivers
The first time you are downloading the TDC Ultra to a computer using the USB port, you will need 
to install the drivers for it. There are two drivers that will be installed, one right after the other. These 
drivers are available on the Downloads section of the JAMAR web site (www.jamartech.com), on 
the installation CD for the PETRAPro software, and as part of the Windows Update feature available 
from Microsoft using an Internet connection.

To install the drivers, first turn the Ultra on, then con-
nect a USB cable to your computer and then to the USB 
port of the Ultra.

The Windows 'Found New Hardware' message will pop up, referencing USB Serial Converter, then 
the Found New Hardware Wizard will appear.

One of the features of Windows XP and Vista is to 
use your Internet connection to search the Windows 
Update web site for any available drivers for USB 
devices you connect to your computer, like the TDC 
Ultra. If you have not used this feature before, you'll 
first see a screen like the one shown to the left when 
you first connect the Ultra.

The drivers for the Ultra are available through this 
feature, so if you'd like to allow the wizard to connect 
to the Internet, select one for the first two options 
and click Next.

After you click Next (or if you have previously 
instructed Windows to always check the Windows 
Update web site for drivers), you'll see the screen 
shown to the left.

This screen is used to tell Windows where to look for 
the drivers it needs. We recommend using the first 
selection, Install the Software Automatically.

Note that whenever possible we recommend you use 
the drivers available through the Windows Update 
web site as this is the easiest method for loading 
the drivers. However, if you are not able to use the 

Windows Update web site, the drivers are also available on the Downloads section of the JAMAR 
web site and PETRAPro installation CDs for versions later than 1.5.0. If you are downloading the 
drivers from the JAMAR web site, be sure to follow the directions listed there. If you would like to 
use the drivers on the PETRAPro CD, insert the CD into your drive.

 Installing USB Drivers

Figure A-1: 
Found New 

Hardware

Figure A-2: 
Installation

Options
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Once you are ready to proceed, click Next. The Wiz-
ard will then start searching for the best available 
drivers and you'll see a screen like the one shown 
to the left.

Once the wizard is finished searching, it will begin 
to load the driver it has found and you'll see a screen 
like the one shown to the left.

Note that if the Wizard finds more than one driver 
(like if you are using Windows Update and also have 
a PETRAPro CD in you drive), the Wizard will list 
all the available drivers. You can then select the one 
you'd like and then proceed.

When the driver is finished installing you'll see a 
screen like the one shown to the left.

Click Finish and you'll complete installing this driver, 
but there's still one more to go. 

Once you click Finish, the Windows 'Found New 
Hardware' message will pop up again, referencing 
a USB Serial Port, and the Found New Hardware 
Wizard will reappear. Don't be alarmed, this is what's 
supposed to happen. There is a second driver that 
needs to be installed to create a virtual comm port.

Figure A-3: 
Searching for

Driver

Figure A-4: 
Installing

Driver

Figure A-5: 
Finished 

Install

Figure A-6: 
Found New

Hardware
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To install this second driver, follow the same steps as the first.

Once the second driver is installed, you may see a message like the one below, prompting you to 
restart your computer.

Restart your computer to complete the process of installing the drivers.

The process of installing the USB drivers has created a virtual comm port on your computer and as-
signed this port a number from 1 to 16. You will need to select this comm port number in PETRAPro 
when you go to download your Ultra. PETRAPro makes this easier to do by only listing the comm 
ports that are available in the download screen. However, if you want to check to see what port 
number the virtual comm port has been assigned, you can do so through the computer's Device 
Manager list.

To access this information, right-click on the 
My Computer icon then select Properties. In 
the System Properties window, click on the 
Hardware Tab, then click the Device Manager 
button. Click the plus sign (+) next to Ports and 
you should see a list similar to the one shown 
below, showing the port number that your com-
puter has assigned.

Figure A-7: 
Installation

Process

Figure A-8: 
Reboot 

Computer

Figure A-9: 
Port

Listings
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 Downloading Using a Serial Port

Older JAMAR data collectors (TDC-12, TDC-8, DB-400, DB-100) download using a serial port. 
To download these units, you will need to have a JAMAR universal cable and an open serial port 
on your computer.

If your computer does not have a serial port, or if you have a conflict on a serial port, an alternative 
is to use a USB to Serial Adapter. These devices allow you to download data using a USB port as if 
it were a serial port. A wide variety of these devices are available, usually for less than $40. More 
information on these devices can be found on our web site at www.jamartech.com/H06000.html.

Note that only a JAMAR Universal Cable (or cable with matching pin configuration) should be used 
for downloading data. The data collectors and universal cable use just three pins (2, 3 & 5) for the 
data transfer. However, some of the other pins on the data collector’s serial port are left open for 
other functions. The universal cable blocks these other pins so no extraneous voltage can be sent 
from the computer to the data collector. If you use a generic serial cable (which has all nine pins 
connected) it is possible that the computer could send out incompatible voltage to the data collector 
that could damage it or cause your data to be lost or corrupted.

To begin the download process, turn the data collector on. (If you are still in data collection mode, 
turn the unit off, then back on. Turning the unit off ends the study and stores it in memory. You can-
not download data while you are in data collection mode.) Connect the universal cable to a serial 
port on your computer. The ports are often labeled on the computer. If you are not sure what port 
you are plugging into, consult your computer manual.

Once the cable is plugged into the computer, plug the 
other end into the port on the data collector then click 
on the Read button of the Main screen and the Read 
JAMAR Counter screen will appear. You can also access 
this screen by going to the File menu, selecting Acquire, 
and choosing JAMAR.

The baud rate setting determines how fast the data will 
be transferred into the program and it must match the 
baud rate set on the data collector. Click the Setup but-
ton and set the baud rate in PETRAPro to match what 
you have selected in your data collector. Once this is set, 
select the com port into which you have connected the 
universal cable.

After making these adjustments, click on the Begin button and you will see a message prompting 
you to begin downloading the data collector. To do this, press the TAB key on the data collector 
until Dump is flashing, then press the DO key. Local should then be flashing. Check the bottom two 
lines of the display to see what the baud rate is set to. If it matches what you set in the software, hit 
DO. If it does not match, tab to Baud and set it accordingly, then go back to Local and hit DO. You 
should then see Begin flashing. Press DO and the download will begin.

When the download is occurring you should see a status bar moving across the bottom of the Read 
JAMAR Counter screen. Once the download is complete separate windows should appears for every 
study contained in the data collector. Each file should then be saved with a permanent file name 
you provide.

Figure A-10:
Read JAMAR 

Counter



PETRAPro Reference Manual

6

 Federal Highway Administration Scheme F

Class 1 - Motorcycles. This class includes all two- or three-wheeled motorized vehicles.  These 
vehicles typically have a saddle-type of seat and are steered by handlebars rather than a steering 
wheel.  This includes motorcycles, motor scooters, mopeds, motor-powered bicycles and three-wheel 
motorcycles.

Class 2 - Passenger cars. This class includes all sedans, coupes and station wagons manufactured 
primarily for the purpose of carrying passengers, including those pulling recreational or other light 
trailers.

Class 3 - Pickups, Vans and other 2-axle, 4-tire Single Unit Vehicles. This class includes all two-
axle, four tire vehicles other than passenger cars, which includes pickups, vans, campers, small motor 
homes, ambulances, minibuses and carryalls.  These types of vehicles which are pulling recreational 
or other light trailers are included.

Class 4 - Buses. This class includes all vehicles manufactured as traditional passenger-carrying 
buses with two axles and six tires or three or more axles. This includes only traditional buses, in-
cluding school and transit buses, functioning as passenger-carrying vehicles.  All two-axle, four tire 
minibuses should be classified as Class 3.  Modified buses should be considered to be trucks and 
classified appropriately.

Class 5 - Two-Axle, Six-Tire Single Unit Trucks. This class includes all vehicles on a single frame 
which have two axles and dual rear tires.  This includes trucks, camping and recreation vehicles, 
motor homes, etc. 

Class 6 - Three-Axle Single Unit Trucks. This class includes all vehicles on a single frame which 
have three axles.  This includes trucks, camping and recreation vehicles, motor homes, etc.

Class 7 - Four or More Axle Single Unit Trucks. This class includes all vehicles on a single frame 
with four or more axles.

Class 8 - Four or Less Axle Single Trailer Trucks. This class includes all vehicles with four or 
less axles consisting of two units, in which the pulling unit is a tractor or single unit truck.

Class 9 - Five-Axle Single Trailer Trucks. This class includes all five-axle vehicles consisting of 
two units in which the pulling unit is a tractor or single unit truck.

Class 10 - Six or More Axle Single Trailer Trucks. This class includes all vehicles with six or more 
axles consisting of two units in which the pulling unit is a tractor or single unit truck.

Class 11 - Five or Less Axle Multi-Trailer Trucks. This class includes all vehicles with 
five or less axles consisting of three or more units in which the pulling unit is a tractor or 
single unit truck.

Class 12 - Six-Axle Multi-Trailer Trucks. This class includes all six-axle vehicles con-
sisting of three or more units in which the pulling unit is a tractor or single unit truck.

Class 13 - Seven or More Axle Multi-Trailer Trucks. This class includes all vehicles 
with seven or more axles consisting of three or more units in which the pulling unit is a 
tractor or single unit truck.
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Appendix

 Export Options

Figure A-14: 
IMC Export 

Options

PETRAPro includes an Export function that allows data to be saved in a variety of formats. To export 
your data, open a data file then go to the File menu and select Export. Select the format you want 
to use from the list of options and you will then be prompted to supply a file name for the exported 
data. Once a file name is supplied, additional information may be required depending on the format 
option you have selected. The options are:

Excel (.xls) – This option allows you to save the data in an Excel 
spreadsheet. After you provide a file name, PETRAPro  will be-
gin to write the file out to Excel. Note that you must have Excel 
already installed on your computer for this export to work.

AAP (*.vol) – This will save the data in an AAP 
format, which was an early standard for traffic anal-
ysis software programs. This format can be used 
to transfer data into programs like Synchro. When 
exporting to this format you are given the option of 
selecting the groups to export. A four digit reference 
number is used when naming the file and you may 
also assign an optional line of text.

ASCII (*.txt) – This will save the data in a delimited text format. When 
exporting to this format you are given the option of exporting just the 
first group, or all groups. You are also given the option of selecting the 
delimiter (the character used to separate data points) for the file. The op-
tions are tab, comma, semicolon, space or user defined.

IMC v3 (*.dfl) – This will save the data in the format of 
the IMC program, which was the original software for use 
with JAMAR hand-held data collectors in the 1980s. The 
IMC file format only allows three lines of comments, so 
you are given the option of selecting the comments you 
want to use. This file format also only uses two groups of 
data, so you are given the option of combining groups.

Figure A-12: 
AAP Export 

Options

Figure A-11: 
Excel

Export

Figure A-13: 
ASCII Export 

Options
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PETRAPro creates an entry in the Windows Registry when it is installed. 
This entry contains the default settings that are configured for the pro-
gram, and can be reviewed or edited if an error is encountered in using 
the program.

WARNING: Incorrect changes to the Windows Registry may 
cause your computer to stop operating correctly. Only use this 
function if you are sure of what you are doing.

The registry entry for PETRAPro can be located at:

HKEY_CURRENT_USER
 Software 
  VB  and VBA Program Settings
   PETRAPro

 Registry Entry

 Statistical Calculations

Peak Hour Factor (PHF)
The Peak Hour Factor (PHF) is used to indicate how evenly the rate of flow of traffic is during the peak hour.  For 
15 minute intervals the equation for determining the PHF is:

     PHF =

Where V equals hourly volume (vehicles per hour) and V
15

  equals the maximum 15 minute volume within the 
hour.

The maximum value a PHF could be is 1.000, which would occur if the volumes in each 15 minute interval of the 
peak hour were equal. This is shown in the example to the left. The minimum value a PHF could be is 0.250, which 
would occur if the total volume for the peak hour occurred in only one interval. This is shown in the example to the 
right.

 

Typically the PHF will fall into a range of 0.700 to 0.980.  The lower the value, the higher the degree of variation 
in volumes during the peak hour.

V
4 x V15

Time Volume
8:00     25
8:15     25
8:30     25
8:45     25

100
4 x 25

= 1.000

Maximum Possible PHF

Time Volume
8:00     0
8:15     0
8:30     100
8:45     0

100
4 x 100

= 0.250

Minimum Possible PHF

Figure A-15: 
Registry 

Entry
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The data that is read by PETRAPro from a JAMAR hand-held data collector is in standard ASCII (text) format. In 
PETRAPro, the temporary file JAMAR.jcd is created every time a data collector is downloaded. This file contains 
all the data that was output from the data collector. The program then uses this file to create the various data files 
you work with in the program, which are in a binary format. If an error occurs during this process, the JAMAR.jcd 
file can be reviewed using any program that will read text files, such as Windows WordPad. The general format of 
the data of each of the supported studies is as follows:

 Data Formats

Standard Turning Movement, Roundabout Movement, Gap, Signalized 
Intersection Delay:
varies*    leader characters (20)
001    count number
001    interval number
01    interval length (min) 
nnnnnnnn    8 digit site code
AAAAAAAAAAAAAAAAAAAA Alpha site code
AAAAAAAAAAAAAAAAAAAA (20 characters) 
hhmm    start time
mmddyy    start date
nnnn,nnnn,...nnnn    data, 10 per line
...
ccc    checksum

* The twenty leader characters vary depending on the study
^^^^^^^^^^^^^^^^^^^^       Standard Turning Movement
CCCCCCCCCCCCCCCCCCCC       Roundabout Movement
@@@@@@@@@@@@@@@@@@@@   Gap
$$$$$$$$$$$$$$$$$$$$       Signalized Intersection Delay

Classification:
####################  leader characters (20)
001    count number
001    interval number
01    interval length (min) 
nnnnnnnn    8 digit site code
AAAAAAAAAAAAAAAAAAAA Alpha site code
AAAAAAAAAAAAAAAAAAAA (20 characters)
s    scheme code
kk    number of classes
hhmm    start time
mmddyy    start date
nnnn,nnnn,...nnnn    data, 10 per line
...
ccc    checksum 

Stop Sign Delay, Saturation Flow and Time-Stamp
varies*    leader characters (20)
001    count number
001    interval number
    (always = 001)
nnnnnnnn    8 digit site code
AAAAAAAAAAAAAAAAAAAA Alpha site code
AAAAAAAAAAAAAAAAAAAA (20 characters) 
hhmm    start time
mmddyy    start date
ss tttt    data, 2 per line
...

ss = switch number (01-16, but not all switches are used)
ttt = # of timer ticks since last time marker (0001-2048)
 1 tick = 15.6 msec
or
ss = 00 for time marker (1 every 30 seconds)
tttt = checksum for all data since last time marker

* The twenty leader characters vary depending on the study
<<<<<<<<<<<<<<<<<<<<  Stop Sign Delay
++++++++++++++++++++  Saturation Flow
RRRRRRRRRRRRRRRRRRRR  Time-Stamp

Spot Speed:
!!!!!!!!!!!!!!!!!!!!   leader characters (20)
001    count number
001    interval number
01    interval length (min) 
nnnnnnnn    8 digit site code
AAAAAAAAAAAAAAAAAAAA Alpha site code
AAAAAAAAAAAAAAAAAAAA (20 characters) 
hhmm    start time
mmddyy    start date
nn     MPH speed data, 1 per line
...
ccc    checksum

Notes:
• Checksum is mod 256 of all characters in interval
• All lines are followed by CR, LF characters
• Last line of data followed by 20 colons “:”
  (end of data character)  

Appendix

Enhanced Turning Movement
AAAAAAAAAAAAAAAAAAAA leader characters (20)
001    count number
001    interval number
    (always = 001)
nnnnnnnn    8 digit site code
AAAAAAAAAAAAAAAAAAAA Alpha site code
AAAAAAAAAAAAAAAAAAAA (20 characters) 
hhmm    start time
mmddyy    start date
ss cc (or ss ttt)   data, 2 per line
...

ss = switch number (01-16)
cc = class number (01-014)
or
ss = 00 for time marker (1 every 60 seconds)
ttt = checksum for all data since last time marker
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